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Preface
 

About this manual
This Profile XP User Manual describes the standard Profile XP applications used to manage 
the day-to-day operation of your Profile XP Media Platform This manual assumes you have 
already installed your Profile XP system using the Installation Guide and Profile XP System 
Guide shipped with your unit.

Using the Profile XP Documentation Set
This manual is part of a full set of support documentation for the Profile XP Media Platform. 
The following illustrates how to use the Profile XP documentation depending on the task you 
are performing.
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Installation Guide
Contains essential steps for 
installing your Profile XP 
system using factory 
default settings.

Contains complete instructions for using 
Profile applications. These manuals include:
- Profile XP User Manual
- ContentShare Explorer User Manual
- Other user manuals you received with 
optional Profile applications.

Installers consult 
the User Manuals 
as needed.

These manuals include:
- PFC500 Instruction Manual
- Profile XP Service Manual     
with NetCentral.

Contains the product description 
and step-by-step instructions for 
modifying system settings. 
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Manual Descriptions
• Installation Guide (for your Profile XP Model) This guide provides step-by-step 

instructions for installing the Profile XP Media Platform using factory default settings for 
all record/play channels. Factory default settings are indicated within the guide. After 
installing the Profile XP system using this installation guide, you can refer to this Profile 
XP System Guide to customize system settings for your installation. 

• Profile XP User Manual Contains complete instructions for using Profile applications to 
operate the Profile XP Media Platform.

• Profile XP System Guide This guide provides all the information you need to go beyond 
factory default settings and customize your system’s configuration to meet your 
site-specific needs. This guide also provides an overview of your Profile XP system, and 
provides all the specifications you need to integrate the Profile XP Media Platform into 
your operation. 

• Profile XP Service Manual with NetCentral Contains information for servicing the Profile 
XP Media Platform, and includes procedures for the following tasks:

- Problem analysis using symptom, problem, solution tables.

- Running diagnostics locally and remotely

- Set up and operation of Portals remote monitoring software.

- Replacing field replaceable units.

• Profile XP Release Notes Contains the latest information about the Profile XP hardware 
and the software release shipped on your system. This information includes software 
specifications and requirements, feature changes from the previous releases, helpful system 
administrative information, and any known problems.

• PFC500/E Instruction Manual Contains information for servicing the Profile XP Fibre 
Channel RAID Storage Chassis (PFC500/E) including step-by-step procedures for 
replacing field replaceable units.
Profile XP User Manual December 1, 2000



How this manual is organized
How this manual is organized
The Profile XP® User Manual supports Profile System Software 4.2 for the Profile XP Media 
Platform. The Profile XP Media Platform uses digital technology to store and produce 
broadcast-quality MPEG video and broadcast quality audio. This manual documents the 
standard software applications that are included on the Profile XP Media Platform: 

Chapter 1 - Introducing the Profile XP Applications
Introduces the standard and optional Profile XP applications. Each application is best suited 
for a specific task. This chapter helps you decide which application to use.

Chapter 2 - Using VdrPanel
Describes how to use the VdrPanel application to record and play back MPEG video and audio 
clips. It also tells you how to configure a channel for external control through an RS-422 port.

Chapter 3 - Using Media Manager
Media Manager manages clips and masters on disk. With Fibre Channel, you can use Media 
Manager to copy or move media between Profile systems. The Transcode Utility included in 
Media Manager converts media between different compression rates.

Glossary
This appendix explain terms used throughout this manual, and in the industry.

NOTE: This manual assumes that you are familiar with basic Microsoft  
Windows  operation.
December 1, 2000 Profile XP User Manual 9
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Terminology and Conventions
Button (graphical) Buttons shown in bold (OK, for example) that you click with the mouse 

pointer. 

Button (mouse) The two or three buttons on the top of the mouse. 

Choosing Choosing menu items, File | Exit, for example. (File | Exit means 
choose the Exit menu item under the File menu.) 

Commands Commands (a:\setup, for example) are shown in bold. 

Clicking Pressing and releasing the mouse button without moving the pointer. 

Ctrl key Hold Ctrl down while pressing other keys in a sequence. 

Double-clicking Pressing and releasing the left mouse button twice without moving the 
pointer. 

Dragging Pressing and holding the mouse button while moving the pointer. 

Moving Changing the location of the pointer on the screen by moving the 
mouse. 

Pointer An arrow or other graphic on the screen indicating the current cursor 
position for selecting or clicking. 

Pointing Positioning the pointer on an object on the display by moving the 
mouse. 

Right-click Pressing and holding the right mouse button. 

Shift key Hold Shift down while pressing other keys in a sequence. 
Profile XP User Manual December 1, 2000
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Introducing the Profile XP Applications

Profile XP Media Platforms store broadcast-quality MPEG video and audio on computer disk 
drives rather than on video tape, allowing almost instant access to any timecode location of 
your video and audio material. 

A Profile XP system is more than just a one-for-one replacement of a VTR: it can have up to 
six record and eight playback video channels in various combinations. Clips are available on 
all channels at once, so you can play a clip on more than one channel at the same time, without 
making a copy of it. Since each channel is independent of the others, each playback can start 
at a different time and at a different place in the clip.

You can even start playing a clip while it’s still being recorded. Just start capturing the clip on 
one channel, wait about five seconds, and then play the clip back on another channel. This kind 
of control makes the Profile XP system an ideal solution if you want to go to air with a clip 
before you have finished recording it.

What sets a Profile XP Media Platform apart from a VTR is its ability to be controlled by 
software applications. Grass Valley Group provides a set of standard and optional software 
applications, described later in this section, that provide basic tools for managing your Profile 
XP Media Platform. 

While you can use any of these applications directly on your Profile XP system, most of them 
will also run on a remote PC. This allows you to control your media platform over an Ethernet 
connection from another room or another building. The NetCentral Plus application, described 
in the Profiile XP Service Manual with NetCentral, even lets you monitor the status of your 
Profile XP from a remote location.

If you don’t find all the capabilities you want in any of the Profile applications, you can turn 
to one of Grass Valley Group’s partners to find exactly the application you need. By using the 
Profile software development tools, described in the next section, these partners have 
developed tools such as automation systems, simple or sophisticated editors and live event 
controllers that exploit all unique features of your Profile XP Media Platform. These 
applications may run locally, over the Ethernet, or control your system through one of its 
RS-422 ports.
, 2000 Profile XP  User Manual 11
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Profile Software Development
The Profile Software Development Kit (SDK) provides an application programming interface 
(API) for libraries of Profile functions. We recommend that you call these functions via 
Microsoft Visual C++ 5.0; however, it is possible to use other languages that permit calls to C 
declared functions (contact your Grass Valley Group representative for more information). 
Software developers can use the API to control the Profile system from third-party hardware 
devices, for example. The API consists of seven libraries: 

• The TekCfg library provides an interface to the Profile configuration. 

• The TekPdr library furnishes calls that inventory and manage movies in Common Movie 
Format (CMF), an internal file format standard for video, audio, and timecode. 

• The TekRem library makes it possible for a remote Windows NT system to control a Profile 
disk recorder over an Ethernet LAN. 

• The TekVdr library provides an interface for playing and recording video and audio clips. 

• The TekVfs library supports low-level access to individual media files in the media file 
system. 

• The TekVme library controls the optional video mix effects board. 

• The TekXfr library supports media streaming of Fibre Channel connections.

Eight RS-422 serial ports come standard on a disk recorder. A disk recorder can issue serial 
commands or receive them from an external device via RS-422 communication lines. The 
Profile Protocol associates each API call with a specific number that can be sent over an 
RS-422 line. The ProLink application monitors Profile Protocol calls over an RS-422 link, 
allowing you to use compatible hardware devices, such as the PRC100 Control Panel, to issue 
commands to a Profile unit. 

Windows applications are also available to control the Profile system. Your media platform 
comes with several standard and optional applications. See “Starting and Closing Profile 
Applications” on page 14 for more information. 

NOTE: Louth and Odetics RS-422 protocols are also supported, although there 
is not a one-to-one correspondence between these protocols and the Profile API. 
Louth and Odetics protocols do not allow you full access to the functionality of 
the Profile system. 
Profile XP  User Manual December 1, 2000
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Starting Your Profile System
Once the unit is properly installed and configured, you are ready to log in for day-to-day 
operations. For instructions on how to install and power-on a Profile XP system, see the 
Installation Guide and Profile XP System Guide that came with the unit.

To log in automatically:

Power up the Profile XP unit, and the start up routine begins. During normal start up, you 
are logged in automatically and the VdrPanel application starts. You can hold down the 
Shift key during start up to interrupt the automatic log in process.

NOTE: If you stop the automatic log in, or if it fails, the Windows NT log in 
dialog box appears. When logging in, remember that this dialog box is 
case-sensitive.

To manually log in:

1. At the Windows NT 4.0 log in window, enter the username: profile (However, you must 
log in as administrator when installing software, performing Windows NT administration, 
starting a service, or setting an Ethernet IP address.) 

2. Use the Tab key to advance to the password field.

3. The password appears as asterisks (*) for password security. For the password, enter: 
profile 

4. Use the Tab key to advance to the From field. 

5. If your domain name or local computer name is not displayed in the box, click in the box 
to access a list of choices. Select your domain or local computer name from the list.

6. Click OK or press Enter.

NOTE: If a log in error message appears, and all the information is correct, try 
deleting the password and clicking OK.
December 1, 2000 Profile XP  User Manual 13
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Starting and Closing Profile Applications
After logging into your Profile system, you see shortcut icons for the Profile applications on 
the Windows NT 4.0 desktop.

Figure 1. Profile Application shortcuts on the Windows NT 4.0 desktop
Profile XP  User Manual December 1, 2000
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Starting an Application
To start a Profile XP application — VdrPanel in these examples — using Windows NT 4.0: 

• Double-click the shortcut icon on the Windows NT desktop. 

Or: 

• Choose Start | VdrPanel. 

Or: 

• Choose Start | Programs | Profile Applications | VdrPanel. 

Viewing Help
To view the Help for an application: 

• Choose Help | Help Topics. 

Or: 

• Click the Help button in a dialog box or a toolbar, if available. 

To view version information (for VdrPanel in this example): 

• Choose Help | About VdrPanel. 

Closing an Application
To close Profile applications: 

• Choose File | Quit, File | Exit or click the Close button. 
December 1, 2000 Profile XP  User Manual 15
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Standard Applications
The following software applications are installed at the factory on every Profile XP Media 
Platform. The short descriptions should help you understand when to use each application.

VdrPanel 
VdrPanel lets you to capture and trim video and 
audio clips and then play them back. It also lets 
you configure your channels for control by 
external devices through the RS-422 ports. By 
default, VdrPanel starts automatically when you 
power-on your Profile system. For more 
information, refer to Chapter 2, “Using VdrPanel.” 

ContentShare Explorer
The new ContentShare Explorer provides an evolving 
tool to manage your assets wherever they are. In this 
release, you can use the search engine to locate your 
clips and masters, then drag and drop to transfer assets 
between systems on your video network, and archive 
and restore clips on a Profile Network Archive 
system. As new capabilities are added, you’ll be able 
to track versions, manage security, and much more. 
Refer to ContentShare User Guide for more 
information.

Media Manager
The Media Manager allows you to manage clips and 
masters on your local Profile XP Media Platform. You 
may also use Media Manager to launch the Transcode 
Utility, or archive and restore clips on a legacy Profile 
Library System directly attached to a Profile Video File 
Server (PDR). Refer to Chapter 3, “Using Media 
Manager.” 
Profile XP  User Manual December 1, 2000
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Transcode Utility
The Transcode Utility, which is started from Media Manager, 
creates new clips in the same compression format but 
different video quality. It can also convert clips from one 
compression format to another (JPEG to MPEG, for 
example) on Profile systems that support more than one 
compression format, such as the PDR300. Refer also to 
Chapter 3, “Using Media Manager.” 
December 1, 2000 Profile XP  User Manual 17
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Optional Applications
The following optional software applications—Tool Box Editor, List Manager and 
TimeDelay—address specific needs that aren’t covered by the standard Profile software 
applications. Tool Box Editor and List Manger are included in the Profile Tool Box package, 
and TimeDelay is available as a separate application.

Tool Box Editor 
The optional Tool Box Editor lets you create new 
media by logging and capturing video and audio 
clips while also providing an inexpensive, 
cuts-only editing system. Refer to the Tool Box 
User Manual.

List Manager 
The optional List Manager allows you to set up 
simple station automation. You can record 
incoming video at predetermined times, send 
incoming video directly to an output, or combine 
all of these functions to increase the automation 
level of you operations. Refer to Tool Box User 
Manual

TimeDelay
TimeDelay allows you to delay incoming video by an 
amount of time you specify. For more information, see 
ToolDelay User Manual.
Profile XP  User Manual December 1, 2000
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Using VdrPanel

Storing media on a Profile XP Media Platform rather than on tape opens the door to almost 
instant access to digital video and audio material. Media is available to all of the Profile XP 
Media Platform’s channels at once, so you can play a video and audio clip on more than one 
channel at the same time. Since each of the channels is independent, playback can start at a 
different time and place in a clip. One of the best features of the Profile XP system is that you 
can start playing material while it’s still being recorded. 

The basic element of digitally stored video and audio is the clip. A clip is a reference to video, 
audio, and timecode material recorded in media files on the Profile XP media disks. A clip has 
a beginning and an end, and, when first recorded, the beginning and end correspond to the first 
and last frames stored in the media file. When you delete a clip, the media file that the clip 
refers to remains on disk if at least one other clip refers to it—only the reference to the media 
file is deleted, not the media itself. 

A clip may refer to the entire media file or just part of it. You can mark in and out points in a 
clip. These marks change the effective beginning and end points of a clip, while not removing 
the associated material from the media file. On the other hand, you can trim media to remove 
material from either end of a clip, which also removes the information from the media file. 
Trimmed material is permanently removed from disk and is no longer available for use. 

The default tool for creating and playing clips on the Profile XP system is VdrPanel. VdrPanel 
provides you with a VTR-like interface—complete with transport controls—to directly 
manage media operations. Once created with VdrPanel, clips are available for use with Profile 
XP applications, such as Tool Box Editor or the List Manager. 

VdrPanel allows you to configure any or all of your channels for operation through a 
controller connected to an RS-422 serial port. These controllers may comply with Louth, 
Odetics, or BVW protocols. 
, 2000 Profile XP  User Manual 19
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Before using VdrPanel to capture clips, you must complete a few steps: 

1. You must select a channel for use with each panel. At the same time, you must decide 
whether you want to use the Windows NT interface (called Panel Control) to capture and 
play clips, or if you want to use an external device to control your Profile XP system. If you 
select an external controller, you must select a port for use with the controller. See 
“Configuring a Panel” on page 21. 

2. You can select timecode panel display, which timecode generators to use, and select 
drop-frame timecode. See “Selecting How to Display Timecode on a Panel” on page 24. 

For information on how to start and close VdrPanel, see “Starting and Closing Profile 
Applications” on page 14. 

The VdrPanel window is shown in Figure 2. By default, the VdrPanel window appears 
automatically at power-up, unless you log in manually. You display all available panels in the 
VdrPanel window—up to eight, depending on your system. Each panel is dedicated to one 
channel. 

Figure 2. VdrPanel window 
Profile XP  User Manual December 1, 2000
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Configuring a Panel
Before you can use a panel, you must first configure it. You must select a protocol and a 
control port for your panel, or select Panel Control to use the VdrPanel to record and play back 
clips without using an external controller. You must also select the channel to use with the 
panel. A channel assigns resources such as video audio, and timecode inputs and outputs, as 
well as encoders and decoders to the panel. Channels are created or modified by Configuration 
Manager. See the Profile XP System Guide for more information about creating and modifying 
channels in Configuration Manager.

Selecting a Channel, Protocol, and Port
1. Click a panel to make it active. 

2. Choose Controller | Configure to open the Channel Configuration dialog box (Figure 3). 

Figure 3. Channel selection dialog box

3. Select the Protocol for the channel, such as Louth Automation. Select Panel Control if you 
want to use only the Windows NT panel to record and play back clips.
December 1, 2000 Profile XP  User Manual 21
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4. If you selected a protocol other than Panel Control, select the communications port that is 
connected to the desired external controller. Ports P1 through P8 are available on the 
RS-422 Connector Panel. COM1 and COM2 are available on the unit’s back panel
(RS-232 DB-9 connectors).

5. Select a channel for use with the panel from the Channel drop-down list box. You can scroll 
through the Channel Information list to see what resources are specified by each channel. 

6. Click OK to have your channel, protocol, and port selections take effect. 

If you use Configuration Manager to change a channel’s name or resources, you must reselect 
the modified channel in VdrPanel for the change to take effect. You may also choose 
Controller | Reacquire Channel to update the channel for the current panel.

Selecting Clip Length (BVW Only) 
If you have chosen a BVW controller, you can specify clip length by setting mark in and mark 
out points:

NOTE: The Set Clip Marks (clip length) dialog box shown here will not appear 
unless the panel controller is a BVW controller. This is not the same as setting 
clip length while in Loop mode. 

1. Click a panel to make it active. 

2. Choose Controller | Clip Length. The Set Clip Marks dialog box appears (Figure 4).

Figure 4. Set Clip Marks dialog box 

3. Enter the mark-in and mark-out points by specifying the hour, minute, second, and frame 
settings. This applies to future clips only, unless you perform step 4.

4. Click Apply to Loaded Clip(s) if you want the mark-in and mark-out points to apply to 
existing clips as well as future clips. 

5. Click OK. 
Profile XP  User Manual December 1, 2000
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Setting Louth Modes 
If you use Louth Automation, you can set a panel to Louth modes. Normally, when a clip is 
cued, a freeze or confidence frame appears on the monitor instead of a regular video input 
feed. In Louth switcher mode, you do not see a confidence frame: you see video input from 
the feed until you play the clip. When the clip is done playing, you immediately see the regular 
video input again. 

Without Louth end mode, you may see a few fields of a following clip, even if you don’t 
intend to play it. Louth end mode ensures that after playing a clip in a list, timecode freezes at 
the first frame of the next clip in that list. 

NOTE: Louth menu commands are available only when the panel controller is 
set to Louth Automation. 

To set a panel to Louth switcher mode: 

1. Click the panel to activate it. The panel controller must be Louth Automation. For 
information on how to set the controller to Louth Automation, see “Configuring a Panel” 
on page 21. 

2. Choose Options | Louth Switcher Mode. A check mark appears next to Louth Switcher 
Mode in the Options menu to show that it is activated.

3. To return the panel to normal mode, choose Options | Louth Switcher Mode again. 

To set a panel to Louth end mode: 

1. Click the panel to activate it. The panel controller must be Louth Automation. For 
information on how to set the controller to Louth Automation, see “Configuring a Panel” 
on page 21. 

2. Choose Options | Louth End Mode. A check mark appears next to Louth End Mode in the 
Options menu to show that it is activated.

3. To return the panel to normal mode, choose Options | Louth End Mode again. 
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Selecting How to Display Timecode on a Panel 
The Timecode Setup dialog box enables you to set the timecode display and the timecode 
source on a channel to the values required for your application.

1. Click in a panel to select it.

2. Choose Options | Select Timecode to open the Timecode Setup dialog box. The 
Timecode Setup dialog box is divided into two groups: Display on Panel and Timecode 
Generator Settings.

Figure 5. Timecode Setup dialog box 

3. Select the timecode to be displayed on the panel from the Display on Panel group:

- LTC Input is a separate signal input via the genlock card.

- VITC Input is the timecode from the VITC input signal. 

- Compute from Field Number calculates the timecode directly from the field number 
of the recorded video. New clips start at 00:00:00:00. 

- TC Rec # displays the recorded timecode. 

- Generator displays the timecode from the generator for the channel. 

4. Set up the timecode generator used by the panel with the Timecode Generator Settings 
group: 

- Free Run causes the timecode generator to continue to advance regardless of the 
current play or record mode of the panel. 

- Freeze locks the timecode at the current value. The value does not advance with time 
nor with changes in the play or record mode of the panel. 

- Lock to Field Number causes the generator to output a timecode locked to the current 
clip’s timecode. When the panel is in stop, the value freezes. When the panel is in play 
or record, the timecode advances normally. During rewind or reverse shuttle, the 
timecode runs backward. 
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- Regenerate pertains to BVW controllers only. When the timecode position is 
changed to a new portion of the clip, and a record operation includes recorded 
timecode tracks (which happens with assemble edits from BVE and other controllers), 
the timecode generator is initialized to match the timecode read from the timecode 
track (VITC or LTC) before the record occurs. 

- The Reset To button resets the timecode to the value entered in the box. The 
generator can be set to this value when Free Run, Freeze, or Lock to Field Number 
is selected. 

5. Click Close. 

Setting Drop-Frame Timecode 
In NTSC and 525/60, you don’t actually get 30 frames per second; the real number is about 
29.97 fps. Timecode usually assumes 30 fps. To account for the discrepancy, drop-frame 
timecode skips or drops two timecode values at the beginning of every minute except every 
tenth minute. This allows timecode to exactly match a real-time clock on 525/60 systems. This 
correction is not needed on PAL or 625/50 systems because the frame rate is exactly 50 fps.

To set drop-frame timecode:

• Choose Options | Drop-Frame or Options | Non-Drop-Frame.

NOTE: This setting applies to all open panels.
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Panel Basics 
In the VdrPanel application, you can display up to eight Panel dialog boxes at a time, one for 
each video channel. Each Panel dialog box has independent controls. A close-up view of a 
Panel dialog box is shown in Figure 6. A description of each Panel function follows.

NOTE: If the panels are stacked, choose Window | Tile Panels.

The VdrPanel interface follows the same conventions as other Windows NT applications: the 
control menu box, title bar, menu bar, minimize and maximize buttons, mouse and keyboard 
all perform as expected. Refer to specific operating information about these items in the 
Windows NT manuals.

Figure 6. Panel dialog box 

1. The Type box shows the type of pictures: I for Intra-coded (I-frame), B for 
Bidirectional-predictive coded, and P for Predictive-coded. 

2. The Size box shows the number of bytes stored for the current frame. The more detailed 
the picture, the higher the number of bytes. The compression rate is set for the channel. Use 
Configuration Manager to change this setting. 

3. The Play/Record mode allows you to choose how your clips will be recorded or played. 
Select Normal to play the selected clip or clip list to the end, freezing on the last field of 
the clip or of the last clip in the list. Select Loop to play the selected clip or clip list 
continuously, looping back to the beginning of the clip when the clip ends, or in the case 
of a clip list, looping back to the first clip in the list when the last clip ends. If you create 
a clip while in Loop mode, you are asked to enter a clip length in the form 00:00:00:00 
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(Hours:Minutes:Seconds:Frames). The Record operation will automatically stop at the 
specified timecode, thus protecting disk storage space. 

4. The Timecode box is the current timecode of the selected clip. To configure your timecode 
display, refer to “Selecting How to Display Timecode on a Panel” on page 24. For example, 
when you use slow motion replays from several camera angles, the timecode can free run 
or freeze. Clicking on the Timecode box brings up the Go To Timecode dialog box. 
Entering a new timecode value and clicking OK moves a clip to a specific timecode 
location. If there is no recorded timecode, VdrPanel displays a timecode calculated from 
the current position (00:00:00:00 or above). 

5. The Stop button halts the current Play, shuttle, or Record function.

6. The Rewind button shuttles the clip backwards to the beginning (the first available field or 
in mark) of the selected clip. Use Go To Clip Beginning or enter a timecode value in the 
Timecode box to move directly to the beginning without shuttling. This button may not be 
available on panels configured as Recorder only.

7. The Record button starts storing the incoming video as MPEG streams and audio under the 
selected clip name. If no clip is selected, a default clip name (pound sign [#] followed by a 
number) is assigned. (See “Defining a New Clip” on page 33.) The record process 
continues until the disk decoder runs out of storage space or you click another command 
button, such as Stop. Recording does not start unless there is a video signal assigned to the 
selected panel and there is disk storage available. This button is not available on Play only 
channels.

8. The Play button runs the selected clip at normal speed. If there are multiple clips in the clip 
list, Play starts with the first selected clip and proceeds through the list. Normal and Loop 
modes determine how the clip or clip list is played. This button is not available on panels 
configured as Recorder only.

9. The Fast Forward button shuttles the clip forward to the end. Use Go to Clip End or enter 
a value in the Timecode box to move directly to the end of the clip without shuttling. This 
button may not be available on panels configured as Recorder only.

10. The PB/EE (Playback/E to E) button determines the action during Stop or Record. If 
you select Playback, the recorded image is displayed as a still during Stop, and audio is 
silenced. If E to E is selected, the input signal is routed through to the display during 
Stop or Record. 

11. The Clip Position Bar displays the relative position of the current frame within the 
current clip. For example, if the Clip Position Bar is to the far left, the frame is at the 
beginning of the clip; if it is at the far right, the frame is at the end. Click on the bar to 
activate it or press j or ↓ . 
December 1, 2000 Profile XP  User Manual 27



Chapter 2    Using VdrPanel 

28
12. The Remove In Mark button removes the in mark and restores the clip to its first 
available field.

13. The Set In Mark button sets the in mark for the current clip at the current timecode (you 
can also press i). When the clip is played, it starts at the in mark instead of the clip 
beginning; however, the portion before the in mark is not lost. Use Remove In Mark to 
remove the in mark. The in mark only affects this instance of the clip. If the clip repeats 
in the clip list or is used by another panel, this in mark is not automatically present.

14. The Trim to In Mark button removes the portion of the current clip preceding the in mark 
(you can also press c). This action affects all copies of this clip on all panels. The 
trimmed material is not retrievable. A warning message and verification prompt are 
displayed before the material is trimmed. 

15. The Trim from Out Mark button removes the portion of the current clip following the 
out mark (you can also press u). This action affects all copies of this clip on all panels. 
The trimmed material is not retrievable. A warning message and verification prompt are 
displayed before the material is trimmed.

16. The Set Out Mark button sets an out mark for the current clip at the current timecode 
(you can also press o [not zero]). When the clip is played, it ends at the out mark; 
however, the portion after the out mark is not lost. Use Remove Out Mark to remove out 
mark. An out mark only affects this instance of the clip. If the clip repeats in the clip list 
or is used by another panel, the out mark is not automatically present.

17. The Remove Out Mark button removes the out mark and restores the clip to its last 
available field.

18. The Go to Clip End button jumps to the end of the current clip. You can also press e. 

19. The Forward One Field button moves the current clip position forward one field. You 
can also press the → key. In addition, Shift + → advances the clip position 10 fields or 5 
frames, and Ctrl + → advances the clip position 100 fields or 50 frames. 

20. The Back One Field button moves the current clip position backward one field. You can 
also press the ← key. In addition, Shift + ← reverses the clip position 10 fields or 5 
frames, and Ctrl + ← reverses the clip position 100 fields or 50 frames. 

21. The Go to Clip Beginning button jumps to the beginning of the current clip. You can 
also press t. 

22. The Shuttle Bar sets the shuttle rate. Use the mouse to drag the pointer to the desired 
shuttle rate (displayed in the Shuttle Rate box). When you click on the shuttle bar, the 
disk recorder enters shuttle mode. You can also press h. 

23. The Shuttle Rate box displays the current shuttle rate. This number ranges from –16.00 
to +16.00, with the positive numbers indicating forward motion, negative numbers 
reverse, and 0.00 still. This number can be set by clicking on the Shuttle Rate box to 
open the Shuttle Rate dialog box, entering a shuttle rate and clicking OK. You can also 
drag the Shuttle Bar to a desired position. If the shuttle rate is set faster than the 
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maximum rate for the controller, the maximum rate is displayed. 

24. The Clip Name box lists the names of the clips in the current clip list.

25. The Group Name box lists the name of the current clip list.

The functions on the Panel dialog box can be accessed directly by clicking on the appropriate 
button with the mouse or by using the shortcut keys shown in Table 1. For example, pressing 
Shift + R starts recording in the active panel.

Table 1. VdrPanel shortcut keys

Shortcut Key Function Shortcut Key Function

Shift + R Record Ctrl + → Forward 100 Fields

w Rewind Ctrl + ← Back 100 Fields

s Stop j or ↓ Jog controls

p or ↑ Play e Go to Clip End

f Fast Forward h Shuttle controls

spacebar Stop t Go to Clip Beginning

Ctrl + A thru H Activate panel A thru H i Set Mark In

→ Forward 1 Field o Set Mark Out (not zero)

← Back 1 Field c Trim to Mark In

Shift + → Forward 10 Fields u Trim from Mark Out

Shift + ← Back 10 Fields F1 Start Help
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Opening a Panel 
If none of the panels are visible, here are the steps to open a panel:

1. Choose Window | Open Panel. The Open a Panel dialog box appears (Figure 7). 

Figure 7. Open Panel dialog box 

2. Select the panel you want to display, Panel A through H. Only panels that are not currently 
open appear in the dialog box. You can also press Ctrl + A through Ctrl + H to activate 
panels A through H. 

3. Click OK. 

Making a Panel Active 
To make a panel active, such as Panel A, do either of the following:
• Click anywhere inside Panel A, if open. 

Or: 
• Choose Window | 1 Panel A: Panel Control. 

Arranging Panels and Icons 
If a panel is obscured by another panel, you can arrange the panels so that they are all 
completely visible. To arrange the panels in this way: 

• Choose Window | Tile Panels.

If you have minimized the panels, you can arrange the icons with: 

• Choose Window | Arrange Icons. 
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Viewing Record Capacity 
The Record Capacity dialog box shows the amount of recording time remaining on the current 
media disk volume according to the current compression presets. To view the recording 
capacity: 

1. Click a panel to make it active. 

2. Choose Window | Record Capacity. A message box appears (Figure 8). In this instance, 
the message box shows the internal disks labeled INT:. The recording time remaining is 
represented in Hours:Minutes:Seconds. For more information on compression settings, see 
the Profile XP System Guide. 

Figure 8. Message box showing record capacity 

3. Click Close. 
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Viewing an Audio Monitor for a Panel 
The Audio Monitor allows you to monitor the level of an audio signal for a panel. To view a 
panel’s audio monitor: 

1. Click a panel to make it active. 

2. Choose Window | Audio Monitor. The Audio dialog box appears, as shown in Figure 9. 
There are only two channels in this example, but up to 32 channels are possible if the 
necessary boards are installed. 

Figure 9. Audio Monitor dialog box 

3. To turn peak hold on or off, choose PeakHold | On or PeakHold | Off. By default, peak 
hold is on. The peak indicators, the white bars in record level controls, indicates the audio 
peak you are currently recording. 

4. To show the record level controls, choose Levels | Show Record Level Controls. To show 
play level controls, choose Levels | Show Play Level Controls. To hide the level controls, 
choose Levels | Hide Level Controls. 

5. To work the record and play level controls independently, choose Levels | Independent 
Controls. To gang the controls, choose Levels | Ganged Controls. 

6. Click Close ( ). 

Play or Record

Play or Record Level Controls

Peak Indicators

Channel Indicators 

Close Button

Level Indicators
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Using Clips
With VdrPanel, you can define, rename and delete a clip. You can load an existing clip or 
group of clips.

Defining a New Clip
There are two methods for defining clips:

• You can create and name an empty clip, then record to it (Name Clip First).

• You can start recording with an empty clip list, then rename the recorded clip to a 
meaningful name (Record Clip First).

Either method creates and stores a named clip. Use whichever method is most convenient for 
you. You can choose VideoClip | Rename Clip at any time to change a clip name.

Name Clips First

To define a clip by first naming the clip:

1. Click in a panel to select it.

Select VideoClip | New Clip to open the New Clip dialog box (Figure 10).

Figure 10. New Clip dialog box

2. Select a drive from the Drive list. The number of drives available depends on your 
hardware.

3. Enter a clip name, up to 32 characters long. Spaces and uppercase characters are acceptable; 
however, uppercase and lowercase characters will not distinguish clip names.

4. Click OK. The new clip is added to the clip list for the selected channel.
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5. If the Loop button is pressed in the panel, a dialog appears asking you to specify the loop 
duration in the form 00:00:00:00.

6. Click the Record button (in the selected Panel dialog box) to begin recording. The 
timecode and compression rate fields are updated.

NOTE: A video input signal must be present on the selected channel for 
recording to start.

7. Click Stop to stop recording.

Record Clips First

To define a clip by recording and then naming the clip:

1. Click a panel to select it.

2. If any clips are listed in the Clips box, choose VideoClip | Eject All Clips to clear the clip 
list.

3. Click the Record button in the selected Panel dialog box to begin recording. A clip named 
#1 (or other number for a unique clip name) appears in the clip list for the panel.

4. If you are in Loop mode, the clip is limited in size to either 1,000 fields or to the last clip 
length specified in the Loop Length dialog box. 

5. Click Stop to stop recording.

If you repeat these steps to record additional clips, they are named sequentially—one 
higher than the previous clip. For example, #2, #3, and so forth.

6. Choose VideoClip | Rename Clip to open the Rename Video Clip dialog box (see 
“Renaming a Clip” on page 36).

7. Click on the clip to be renamed (such as #1).

8. Enter the new name in the To field. Spaces and uppercase characters are acceptable; 
however, uppercase and lowercase characters will not distiguish clip names.

9. Click OK.
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Loading and Playing a Clip
To load and play a clip:

1. Click in a panel to select it.

2. If the clip is already loaded, select it from the Clips box and go to step 7.

3. If the clip is not loaded, choose VideoClip | Load Clip to open the Load Clip dialog box.

4. If the clip you want to load is on a different drive, select a different disk drive in the Drive 
box.

5. Select the clip to load—Richter in this example (see Figure 11).

6. Click OK.

7. Click the Play button in the selected Panel dialog box to begin playing the clip.

8. The Normal or Loop modes determine how play back occurs: 

- Normal mode plays the selected clip or clip list to the end, freezing on the last field 
of the clip or of the last clip in the list. 

- Loop plays the selected clip or clip list continuously, looping back to the beginning 
of the clip when the clip ends, or in the case of a clip list, looping back to the first clip 
in the list when the last clip ends. 

Figure 11. Load Clip dialog box 
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Renaming a Clip
To rename a clip:

1. Choose VideoClip | Rename Clip. The Rename Video Clip dialog box appears.

Figure 12. Rename Video Clip dialog box 

2. If the clip you want to rename is in a different list, select it from the Drive box.

3. Select a clip from the Rename box. The clip name appears in the To box.

4. Edit the current name or delete the name and enter a new one. Clip names can have up to 
32 characters. Spaces and uppercase characters are acceptable; however, uppercase and 
lowercase characters will not distiguish clip names. 

5. Click OK. 
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Setting Clip Protection
To set clip read-only protection:

1. Choose VideoClip | Set Clip Protection and the Set Clip Protection dialog box appears.

Figure 13. Set Clip Protection dialog box 

2. If the clip you want to protect is in a different list, select it from the Drive box.

3. To protect a clip, select a clip in the Play/Record box and then click Protected. The clip is 
now protected as read-only.

4. To unprotect or unlock a clip, select a clip in the Read Only box and then click 
Unprotected. The clip is no longer protected.

5. Click OK.
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Striping a Clip
Striping timecode with VdrPanel allows you to complete a striping process faster than real 
time. For example, on a traditional VTR, it might take you an hour to stripe a one-hour clip. 
But with VdrPanel, you can stripe a one-hour clip in a matter of minutes.

To stripe timecode on a previously recorded clip:

1. Choose VideoClip | Stripe Clip and the Stripe Timecode dialog box appears.

Figure 14. Stripe Timecode dialog box 

2. Enter the timecode you want to start the clip with, in the form 00:00:00:00.

3. Enter up to eight digits to mark the clip with user bits.

4. Click OK when complete.

Setting Long or Short Clip Names
Long clip names display the full path name of the clip, for example, INT1:\default\clipname. 
Short clip names display only the clip name. Clip names are shown in Clip Name box in a 
Panel.

To set the clip name to be short or long:

• Choose Options | Display Short Name or Options | Display Long Name.

NOTE: This setting only applies to the current panel. Each panel can have a 
different setting for clip name length.

Ejecting All Clips
To eject all clips:

1. Choose VideoClip | Eject All Clips.

2. All clips in the Clips box in the Panel are ejected immediately.
Profile XP  User Manual December 1, 2000



Deleting a Clip
Deleting a Clip
To delete a clip:

1. Choose VideoClip | Delete Clip to open the Delete Clip dialog box.

Figure 15. Delete Clip dialog box 

2. If the clip you want to delete is on a different drive, select it in the Drive box.

3. Select the clip or clips you want to delete.

4. Click OK when complete. A message box appears telling you which file is being deleted.
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Clip Lists
You can save and organize clips into lists (also called groups). You can load a saved group of 
clips. You can also save an existing group of clips under a different name. You can also create 
and later edit a list of clips. The groups that you save can be used in VdrPanel, but not in any 
other Profile XP application.

Saving a Group of Clips in a Clip List
A clip list can be saved and loaded later. To save a clip list as a group:

1. Click within the specific Panel dialog box to select the panel where the clip list is 
currently displayed.

2. Choose File | Save Group of Clips and the current list of clips, as shown in the Clips box, 
is saved in the current group (.grp). If the clips have not been saved in a group previously, 
the Save Group of Clips dialog box appears.

Figure 16. Save Group of Clips dialog box 

3. If you have not already saved the group, choose File | Save Group of Clips As.
The Save As command enables you assign a different name to an already named group of 
clips, preserving the contents of the original group. The saved group can be loaded at any 
time with VideoClip | Load Group.
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Playing a Clip List
To play a list of clips:

1. Click within the specific Panel dialog box to select the panel.

2. Choose VideoClip | Load Group if the clip list you want to play is not currently 

loaded.

Figure 17. Load Group of Clips dialog box 

3. Select the group and click OK. In this example, the group is Seismic.grp.

4. Click on the first clip in the clip list.

5. Click Play to start playing the clip list.
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Editing a Clip List
To edit a clip list (group of clips):

1. Click a panel to select it.

2. Choose Video Clip | Load Group if the clip list to be edited was previously saved as a 
group. Select the group and click OK.

3. Choose VideoClip | Edit Clip List to open the Edit Clip List dialog box.

Figure 18. Edit Clip List dialog box 

4. To add a clip to the current list loaded in step 1, select a clip in the Clips box and then click 
Add. It is added to the Clip List box (with a long clip name).

5. To remove a clip from the current list, select a clip from the Clip List box, and click 
Remove to remove the clip from the list. This does not delete the clip from disk—it simply 
removes a reference from the clip list.

6. To edit a different group, click Add Group to bring up the Load Group of Clips dialog box.

7. Click OK when complete.
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Setting In and Out Marks in Clips
You can set a temporary beginning and ending to a clip by marking an in point, an out point 
or both. The video and audio data is not lost, however: it simply is not used when the clip is 
played. For example, if you set a mark-in point five seconds into a clip, it plays at the five 
second mark instead of at the beginning, but if you remove a mark-in, it returns the beginning 
of the clip to the actual clip start.

NOTE: Setting in and out marks applies to Panel Control only. It is not 
recommended for other protocols.

Setting Marks
To set a new in mark and out mark in a clip:

1. Click a panel to select it.

2. Create a clip, load a clip, or load a clip list and then select a clip from the list. The Clip 
Position Bar is all the way to the left and the Timecode is 00:00:00:00.

3. Use the transport controls, drag the Clip Position Bar, or click on the Timecode display to 
enter a timecode to locate the frame where you want to set the in mark.

4. Click Set In Mark. The Timecode display remains the same, but the Clip Position Bar jumps 
to the far left, indicating the mark-in point on the clip.

5. Use the transport controls, drag the Clip Position Bar, or click on the Timecode display to 
enter a timecode to locate the frame where you want to set the out mark.

6. Click Set Out Mark. The Timecode display remains the same, but the Clip Position Bar 
jumps to the far right, indicating the mark-out point of the clip.

7. Drag the Clip Position Bar to the beginning of the clip.

8. Click Play. The clip starts at the in mark and stops at the out mark.

Removing Marks
To remove in and out marks from a clip: 

1. Select a clip containing marks in the Clip Name box. 

2. Click the Remove In Mark button to remove a mark-in point and reset the clip beginning 
to the actual start of the clip. 

3. Click the Remove Out Mark button to remove the mark-out point and reset the clip ending 
to the actual end of the clip. 
December 1, 2000 Profile XP  User Manual 43



Chapter 2    Using VdrPanel 

44
Trimming Clips 
You can trim a clip from the beginning of the clip to the in mark or from the out mark to the 
end of the clip. This action affects all copies of the clip on all panels. The trimmed material is 
not retrievable. A warning message and verification prompt are displayed before the function 
completes.

To trim a clip:

1. Select a clip with either in or out marks or both in the Clip Name box. 

2. Click the Trim to Mark button to remove the portion of the current clip preceding the in 
mark. 

3. Click the Trim from Out Mark button to remove the portion of the current clip following 
the out mark. 
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Using Media Manager

The Profile Media Manager allows you to have access to digitally stored media and provides 
tools for managing that media—such as explore, cut, copy, paste, and delete. Media may be 
stored locally your Profile XP system, or it may be on a remote Profile system or its directly 
attached library system. You can also transfer media stored on any Profile system on your 
Profile network via a Fibre Channel connection.

Digital video and audio media may be stored in volumes. A volume is a disk set or file system 
on one of the following machines, including attached external media drives:

• PVS1000 or PVS2000 Media Platform

• PDR200, PDR300 or PDR400 Video File Server

• PDR100 Professional Video Disk Recorder

Video and audio clips can also be stored on digital tape cartridges in the PLS20 and PLS200 
Profile Library Systems, or on any other supported directly attached digital tape library.

If you move media between Profile systems, keep in mind the capabilities of your machines. 
For example, you can transfer a DVCPRO 25 clip from a PDR400 to a PVS1000, but you 
cannot play it on that machine. PVS1000 systems play and record MPEG clips only.

With Media Manager, you view media in a tree structure. On disk, media may consist of video 
and audio clips and masters. Clips and masters are organized into bins that are kept on a 
volume or file system. A bin is a container for clips and masters, similar to a directory on a 
computer. A clip refers to segments or portions of a media file or a media file in its entirety. 
A master is an edited sequence of clips. On a cartridge in a library system, media also consists 
of clips and masters. Cartridges are divided into one or more partitions.
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Starting and Exiting the Media Manager
To start the Media Manager application with Windows NT: 

• Double-click the Media Manager shortcut icon.

Or: 

• Choose Start | PDR Applications | Media Manager.

The Media Manger window appears (see Figure 19). The tree pane is on the left and the 
contents pane is on the right. What appears in the contents pane depends on what you select 
in the tree pane. For example, if you select the volume icon INT: in the tree pane, the Recycled 
and default bins appear in the contents pane. If you select a bin, the masters and clips in that 
bin appear in the contents pane. Masters and clips will only appear in the contents pane.

Figure 19. Media Manager window 

To exit the Media Manager, choose File | Exit.

A message box is displayed, asking you to confirm that you really want to exit the Media 
Manager application. Click on the Yes button to confirm the exit or the No button to cancel 
the quit command.

Whenever you start the Media Manager, a Hardware Communication Monitor is also started, 
if it is not already running. This program makes calls to the disk recorder and keeps track of 
the Profile host file (profile.hst) which lists Profile systems on the network. The Hardware 
Communication Monitor is normally invisible in its operation, but is essential to the operation 
of Media Manager. It appears in the Processes tab of the Windows NT Task Manager as 
VMHWCOM.EXE; ending this process will stop Media Manager as well.
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Starting Other Applications from the Tools Menu
You can start other tools and applications from Media Manager’s Tools menu:

• Choose Tools | Transfer Monitor to start the Transfer Monitor tool. See “Viewing the 
Transfer Monitor” on page 84. 

• Choose Tools | Media Manager to start another instance of the Media Manager. 

• Choose Tools | Tool Box Editor to start the optional Tool Box Editor, if available. See 
the Profile Tool Box User Manual. 

• Choose Tools | List Manager to start the optional List Manager, if available. See the 
Profile Tool Box User Manual. 

• Choose Tools | Transcode to start the Transcode Utility. This utility converts media 
between different compression formats, such as from JPEG to MPEG. You can also use 
the Transcode Utility to create a new clip with the same compression format, but a 
different compression setting. See “Using the Transcode Utility” on page 63. 

When an application is started from the Media Manager, it initially connects to the machine 
that was selected in the Media Manager’s machine list box. If the application is not installed, 
an error occurs.

Viewing and Hiding the Toolbar and Status Bar
By default, the toolbar is visible. To hide it:

• Choose View | Toolbar.

To make it visible again, choose View | Toolbar again.

By default, the status bar is visible. To hide it:

• Choose View | Status Bar.

To make it visible again, choose View | Status Bar again.

To refresh the tree and contents panes:

• Choose View | Refresh or press F5.

Viewing Help and Software Version Information
To view Help topics on Media Manager:

• Choose Help | Media Manager Help Topics.

To view program and software version information and copyright:

• Choose Help | About Media Manager.
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Connecting to a Remote Machine
You can connect from your local Profile XP machine to any remote Profile machine. You can 
also connect remotely from any PC running Windows NT 4.0. A local Profile machine refers 
to a Profile system on which you are currently using Media Manager. A remote Profile 
machine refers to a Profile system that is connected to your local system via an Ethernet local 
area network (LAN).

The Hardware Communication Monitor makes calls to the disk recorder, manages the 
contents of the Profile host file (profile.hst), owns connections to the machines listed in the 
host file, and passes on change notifications received from each of these machines when other 
applications—such as other instances of Media Manager—are running simultaneously.

While Hardware Communication is initializing, Media Manager shows the Hardware 
Communication Monitor message box. If you click the OK button, this message box is 
minimized. 

To connect to a remote Profile machine on your Profile network: 

1. Choose Add/Remove Machine from the File menu or from the shortcut menu with a 
right-click on a machine, volume, or network icon in the tree pane. You can also click the 
Add/Remove Machine button on the toolbar. The Add/Remove Machine dialog box 
appears (see Figure 20). The label Local appears after the name of the local Profile 
machine.

Figure 20. Add/Remove Machine dialog box
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2. To add a remote Profile machine to the network host list, click Add. The Add Network Host 
dialog box appears.

Figure 21. Add Network Host dialog box

3. Enter the name of the machine in the New Host Name box. This can be the host name or 
the machine’s IP address (such as 128.161.37.138).

4. Click OK. The new host name is added to the network host list. You can click the Add 
button again to add as many machine names as you want.

5. Click OK. The connection status message box appears to show the progress of new 
connections.

To remove a Profile machine from the network host list:

1. Choose Add/Remove Machine from the File menu or from the shortcut menu with a 
right-click on a machine, volume, or network icon in the tree pane. You can also click the 
Add/Remove Machine button on the toolbar. The Add/Remove Machine dialog box 
appears. 

2. Select the name of the machine you want to remove in Network Host List box.

3. Click Remove.

4. Click OK.
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Viewing the Media Hierarchy
The Media Manager window is divided into two main sections: the tree and contents panes. 
Clips and masters appear in the contents pane. Items are listed alphabetically.

In the tree pane, you can expand or collapse the tree hierarchy by clicking on the + (plus) or – 
(minus) control buttons, as shown in Figure 22. If you click on a + button, the tree hierarchy 
is expanded or opened so you can see the branch. For example, under a volume, you see bins. 
Clicking on the – button collapses or closes the associated branch of the tree, hiding the bins 
under the volume. 

To explore the contents of an item, select the icon representing it and then choose Explore 
from the shortcut menu which is displayed with a right-click. If present, clips and masters are 
displayed in the contents pane. In this pane, you see information about the media: 

• The name of the clip or master. 

• The length of the media in the form 00:00:00:00 (Hours:Minutes:Seconds:Frames). 

• The compression format of the media: MPEG, DVCPRO or JPEG. 

• The date and time the media was last modified, in the format: 12/2/94 9:40 PM (Month/
Day/Year Hours:Minutes AM/PM). 

Figure 22. The Media Manager tree pane 

The icons shown in tree pane are explained in more detail here.

The Profile network icon is the root for all other items in the tree pane. 

Profile machines. Each icon is labeled with the Profile machine’s name. A Profile 
can be a local machine or one connected via Ethernet alone.

A Profile machine connected via Ethernet and Fibre Channel. 
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An unconnected machine icon. Appears if no connection could be made. This icon 
cannot be expanded.

A non-Profile server that recognizes Media Manager connection requests. Media 
may be copied to this server from other machines on the Fibre Channel network.

A volume. A machine’s storage is divided into one or more volumes. The 
volume icon represents a physical set of disks. A Profile XP has a single volume 
comprised of all of its connected RAID disks. Older Profile systems may have 
several —either an internal disk set, and external expansion box (such as the 
PDX208), or a RAID disk array (PRS250).

A closed bin. 

An open bin. 

A Recycle bin appears below each volume.

A master. 

A locked master. 

Clips and archived clips with audio and video. 

Locked clips and archived clips with audio and video. 

Clips and archived clips with no audio.

Locked clips and archived clips with no audio. 

Clips and archived clips with audio only (no video). 

Locked clips and archived clips with audio only (no video). 

An item in the Profile clip database that Media Manager does not recognize. 

A library system – appears after volumes. The library icon appears only on 
machines directly connected to a Profile library system. 

A cartridge – appears below the library icon. 

A cartridge that is out of the library. 

A cleaning cartridge – may appear anywhere in the cartridge list.

An unformatted cartridge.

An unformatted, out-of-library cartridge. 

Cartridges that are in an unknown state. 

An unknown, out-of-library cartridge. 

A partition – appears under cartridges. This is a closed partition. 

An open partition. 
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Toolbar
The Media Manager toolbar provides one-button access to commands:

Add/Remove Machine: Opens the Add/Remove Machine dialog box.

Select Current Machine box: Expands the machine item in the tree.

Up One Level: Goes to the folder one level up. 

Cut: Removes the selected items and copies them onto the clipboard. Use Paste to put 
them in the new location. 

Copy: Copies the selected items to the clipboard. Use Paste to put them in the new 
location. 

Paste: Inserts the items you have copied or cut into the selected location. 

Delete: Deletes the selected items. 

Properties: Displays the properties of the selected item. 
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Copying Media
To copy one or more clips or masters:

1. In the contents pane, select a clip or master. To extend the selection, press Shift-Up Arrow 
or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the 
contents pane.

2. Choose Copy from the Edit menu or from the shortcut menu with a right-click. You can 
also click the Copy button on the toolbar.

3. Select the location where you want to paste the item. This can be another bin or anywhere 
in the contents pane when a bin is selected. The selected location may even be in another 
Media Manager window. If both the source and the destination locations reside on 
machines connected to the Fibre Channel network, you may copy between machines.

4. Choose Paste from the Edit menu, or from the shortcut menu with a right-click. You can 
also click the Paste button on the toolbar. A clip may be pasted into the same bin it was 
copied from. In this case the clip is automatically renamed. Media Manager automatically 
suggests a new name that does not conflict with any other item at the selected location. The 
new name is based on the old name with the addition of a number: source becomes 
source_1. When you are copying clips to a volume other than the source volume on a 
Profile system or an library system, Paste Special is available as an option on the Edit and 
right-click shortcut menus.

NOTE: It is possible to play clips or masters with VdrPanel or Tool Box Editor while 
they are being copied over Fibre Channel.

To copy a bin:

1. In either the tree pane or the contents pane, select a bin.

2. Choose Copy from the Edit menu or from the shortcut menu with a right-click. You can 
also click the Copy button on the toolbar.

3. Select another bin into which you want to paste the first bin’s contents. The selected 
location may even be in another Media Manager window. If both the source and the 
destination locations reside on machines connected to the Fibre Channel network, you may 
copy between machines.

4. Choose Paste from the Edit menu, or from the shortcut menu with a right-click. You can 
also click the Paste button on the toolbar. The bin may be pasted into the same bin it was 
copied from. In this case the bin is automatically renamed. Media Manager automatically 
suggests a new name that does not conflict with any other item at the selected location. The 
new name is based on the old name with the addition of a number: source becomes 
source_1. 

NOTE: Copying a bin means that all clips and masters in the bin are copied to the new 
location.
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Using Paste Special
Paste Special is a method of pasting clips or masters that are currently on the clipboard as a 
result of a copy or cut operation. Paste Special is enabled only when you have selected a bin 
on a different volume a bin on a remote machine, or a partition in a library system. 

Unlike Paste, which always copies the material between a clip’s mark in and out points, 
Paste Special offers you the option of copying all the media that the clip references. To use 
Paste Special after placing media on the clipboard, choose Paste Special from the Edit 
menu or the right-click shortcut menu. When the Paste Special dialog box appears, click the 
button for the paste option you prefer, then click OK.

Figure 23. The Paste Special dialog box

Moving Media
To move a clip or master to another bin:

1. In the contents pane, select a clip or master. To extend the selection, press Shift-Up Arrow 
or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the 
contents pane.

2. Choose Cut from the Edit menu or from the shortcut menu with a right-click. You can also 
click the Cut button on the toolbar.

3. Select the location where you want to paste the media. This can be another bin or anywhere 
in the contents pane when a bin is selected. The selected location may even be in another 
Media Manager window. If both the source and the destination locations reside on 
machines connected to the Fibre Channel network, you may copy between machines.

4. Choose Paste from the Edit menu, or from the shortcut menu with a right-click. You can 
also click the Paste button on the toolbar. Pasting media into the same bin has no effect.

To move a clip or master using Paste Special:

1. In the contents pane, select a clip or master. To extend the selection, press Shift-Up Arrow 
or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the 
contents pane.

2. Choose Cut from the Edit menu or from the shortcut menu with a right-click. You can also 
click the Cut button on the toolbar.

3. Select the location where you want to paste the media. To use Paste Special, you must 
select a bin on a different volume, a bin on a remote machine, or a partition in a library 
system.

4. Choose Paste Special from the Edit menu, or from the shortcut menu with a right-click. 
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When the Paste Special dialog box appears, click the button for the paste option you prefer, 
then click OK.

To move a clip or master using drag and drop:

1. In the contents window, select one or more clips or masters.

2. Drag the selection and drop it at the appropriate location. This can be a bin or anywhere in 
the contents pane when a bin is selected. The selected location may even be in another 
Media Manager window. The tree pane will automatically scroll when dragging a bin to the 
very top or bottom of the tree.

If you hold down the Ctrl key when you drop the item, the item is copied to the new location, 
not moved. Dragging a clip or a master to a different machine or volume always results in a 
copy—the original clip is not deleted.

When copying or moving clips to a new location, if a clip or master with the same name 
already appears at that location, you will be prompted to change the name or cancel the 
operation, as shown in Figure 24. 

Figure 24. Confirm Copy dialog box 

Duplicating Media
To duplicate media means that you copy a clip or master and the underlying media files that 
the clip or master reference. A normal copy operation between locations on the same Profile 
machine does not copy the associated media files, only references to those media files. 

NOTE: You can play clips or masters with VdrPanel or Tool Box Editor while Media 
Manager is duplicating the clip or master. This is only practical for longer media. 

To duplicate a clip or master: 

1. In the contents pane, select the clip or master you want to duplicate. 

2. Choose Duplicate from the Edit menu or from the shortcut menu with a right-click. The 
Duplicate operation always automatically renames the new clip. 
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Creating, Renaming and Deleting Bins
A bin can have a name up to 32 characters long. Spaces are legal characters, but count for two 
characters. Colons (:) and slashes (/) are illegal. Tildes (~) are illegal as a first character in a 
bin name. 

To create a new bin:

1. In the tree pane, select the machine or volume where you want to create the new bin. When 
a volume icon is selected, the new bin is added to that volume. When a machine icon is 
selected, a new bin is created in the first volume in that machine.

2. Choose New Bin from either the File menu or from the shortcut menu with a right-click.

3. A new bin called NewBin is placed in the tree. The bin name is highlighted so you can 
change it. Accept the new bin name by pressing Enter.

NOTE: Renaming a bin involves modifying the path of every clip or master in the bin 
to reflect the new name. If a clip or master cannot be renamed because it is locked or 
in use, you end up with two bins: one with the old name and one with the new one. The 
clip that could not be modified remains in the bin with the old name.

To rename a bin:

1. Select the bin in either the tree or contents pane.

2. Choose Rename from either the File menu or from the shortcut menu with a right-click. 
You can also select the bin a second time.

3. The name of the bin is highlighted. Type a new name for the bin and press Enter.

NOTE: Deleting a bin involves deleting every clip or master currently in the bin. If a 
clip or master cannot be deleted because it is locked or in use, the bin is not deleted 
either—it will only contain those clips or masters that could not be deleted. The rest 
go to the Recycle bin or are deleted directly.

To delete a bin:

1. Select the bin or bins in either the tree or contents pane.

2. Press Delete, Backspace, choose Edit | Delete or with a right-click, choose Delete from 
the shortcut menu. Press Shift-Delete to skip the Recycle bin and delete the bin or bins 
immediately.

3. The bin icon disappears from the tree and the contents of the bin are moved to the Recycle 
bin.
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Renaming Clips and Masters
A clip or master can have a name up to 32 characters long. Spaces are legal characters, but 
count for two characters. Colons (:) and slashes (/) are illegal in clip and master names. Tildes 
(~) are only illegal as first characters. 

To rename a clip or master:

1. Select the clip or master in the contents pane.

2. Choose Rename on the File menu or with a right-click. You can also select the item a 
second time.

3. The name of the clip or master is highlighted. Type a new name for the clip or master and 
press Enter.

Deleting Clips and Masters
When a clip or master is deleted, it is just moved to the Recycled bin. It is permanently deleted 
when the Recycled bin is emptied.

To delete a clip or master:

1. Select the clip or master in the contents pane.

2. Press Delete, Backspace, or choose Delete on the File menu or from the shortcut menu 
with the right-click. Press Shift-Delete to skip the Recycled bin and delete the material 
immediately. 

3. The clip or master icon disappears from the tree and is moved to the Recycled bin.

Always Deleting Clips and Masters Immediately
To always delete media immediately, avoiding the Recycled bin: 

1. Select the bin labeled Recycled in the tree pane. 

2. Choose Properties with the right-click or from the File menu. The Recycled Bin Properties 
dialog box appears (see Figure 25). 

3. Click the Options check box to enable immediate removal of deleted items.

4. Click OK. 
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Figure 25. Recycled Bin properties dialog box 

Emptying the Recycled Bin
When a clip or master is deleted, it is moved to the Recycled bin and is permanently deleted 
when the Recycled bin is emptied. If an item of the same name is in the Recycled bin, the new 
item is automatically renamed.

To empty the Recycled bin:

1. Select the bin labeled Recycled in the tree pane.

2. Choose Empty Recycle Bin with a right-click or from the File menu. 
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Viewing Properties
Media Manager lets you view the properties of a volume, media properties for clips and 
masters, and properties for a library system (see “Viewing Library, Cartridge and Archived 
Clip Properties” on page 79). 

To view volume properties: 

1. Select a volume in the tree pane. 

2. Choose Properties from the File menu or from the shortcut menu with a right-click. You 
can also click the Properties button on the toolbar. The Properties dialog box for volumes 
appears (see Figure 26). 

Figure 26. Properties dialog box for volumes 
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To view media properties: 

1. Select a clip or master in the contents bin.

2. Choose Properties from the File menu or from the shortcut menu with a right-click. You 
can also click the Properties button on the toolbar. The Properties dialog box for clips or 
masters appears (see Figure 27).

Figure 27. Properties dialog box for clips or masters 

3. Click the General tab to view these properties:

- A preview frame of the clip or master to help identify it. Preview frames are not 
available for MPEG masters.

- The name of the clip or master.

- How many tracks the clip or master uses for both audio and video.

- The video format, either NTSC or PAL. NTSC clips are recorded with either 
drop-frame or non-drop-frame timecode.

- The compression format, either MPEG, DVCPRO, or JPEG. 

- The length of the clip or master. The length is shown in timecode format: 00:00:00:00 
(Hours:Minutes:Seconds:Frames). 

- The size of the media in megabytes (MBytes). 

- The date and time that the media was created and the date and time it was last 
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changed. The date and time the media was created or last changed is shown in the 
format: 12/2/94 9:40 PM (Month/Day/Year Hours:Minutes AM/PM). 

4. Click the Locked box to lock (or unlock) the media under Media Manager. Clips and 
masters with the locked attribute cannot be renamed, deleted, or modified in any way. 

If the Read Only Media box is checked, it means that the media is protected under 
VdrPanel and cannot be deleted or rerecorded, but you can change marks. See “Setting 
Clip Protection” on page 37. 

5. Click the Transcode tab to view the transcode history (shown in Figure 28) for the master 
or clip. Each entry on the history page contains the date and time of the conversion, user 
description, target format, and when applicable, data rate, chrominance value, and GOP 
structure.

Figure 28. The transcode history page
December 1, 2000 Profile XP  User Manual 61



Chapter 3    Using Media Manager 

62
Finding Clips and Masters
You can locate clips and masters anywhere on the Profile network. If you select the Profile 
Network icon, you will search all machines and libraries on the network. If you select a 
machine, your search will be limited to that machine’s volumes and attached library. If you 
select a cartridge in a library, your search includes all partitions in the cartridge.

1. Select the item where you want to begin your search in either the tree or contents panes.

2. Choose Find on the Edit menu or from the shortcut menu with a right-click. The Find 
dialog box appears (see Figure 29).

Figure 29. Find All Files dialog box

3. Enter the name of the clip or master in the Named box—in this example, 10-28-97. The 
Look In box indicates where the search will begin. 

NOTE: Wildcards are not supported as search items. You must provide the exact name 
of the item. 

4. Click Find Now. Click Stop to end the search. When a match is found, the result is 
displayed in the box at the bottom of the Find All Files dialog box, as shown in Figure 29. 

5. If you double-click an item in the list of found items, the tree pane is expanded and the item 
is selected in the contents pane. 

6. You can copy an item from the found list by holding the Control key and dragging the item 
to the desired location, or you can move it by dragging it without the Control key. 

7. Click Close when you have completed your search. 
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Using the Transcode Utility 
NOTE: The Transcode Utility works only with standard definition video formats. You 
cannot use it with high definition video.

If you have different types of codecs or encoders and decoders in your Profile system, you may 
wish to convert clips from one compression format to another, such as from JPEG to MPEG 
on a PDR300. If your Profile system supports only one compression format, such as MPEG 
on a PVS1000, you can use the Transcode Utility to create new clips with a different video 
quality. The Transcode Utility is a tool that makes format conversions easy. The Transcode 
Utility converts media files—clips and masters—in several different ways. For example, 
depending on the Profile system’s capabilities, you may be able to convert: 

• From MPEG to MPEG using a different video quality 

• From JPEG to JPEG using a different video quality 

• From JPEG to MPEG 

• From MPEG to JPEG 

• From JPEG to DVCPRO

• From DVCPRO to JPEG

NOTE: Converting a low-quality video clip to a higher quality (higher bit rate) will not 
improve the video quality of the clip, though it will consume more disk space. 

The Transcode Utility is started from the Tools menu in Media Manager. 

Figure 30. Transcode Utility window 
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To convert clips or masters: 

1. Select one or more clips or masters that you want to transcode in Media Manager’s contents 
pane. 

2. In Media Manager, choose Tools | Transcode. The Transcode Utility dialog box appears 
with the selected media in the transcode list. 

3. You may add more clips or masters to the transcode list by dragging them from Media 
Manager and dropping them on the list. You can also transfer media using Copy and Paste 
commands. 

4. In the Convert tab, select the target format, either MPEG, DVCPRO, or JPEG. 

Figure 31. Transcode Utility dialog box, Convert tab 

5. In the Video Quality box, select a video quality if you want something other than the default 
(Medium). The higher the quality, the more disk space is used. 

6. To change a custom quality setting, click the button next to the Video Quality list box, and 
the Custom Video Quality Settings dialog box appears. Select either Custom1 or Custom2 
in the Video Quality list box. When selected, you can change the name of a custom setting. 
Click Undo to cancel changes and OK when done. 
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- For JPEG (see Figure 32 and Table 2) select a video quality with the slider. You can 
move the slider with the mouse or arrow keys. 

Figure 32.  JPEG Custom Video Quality Settings dialog box  

Table 2. JPEG video quality (compression) 

Quality Settings Compression in 
Mbps

Draft 12 

Low 24 

Medium (default) 36 

High 48 

Custom 1 or 2 6–54 
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- For MPEG (see Figure 33 and Table 3) select a chrominance value, either 4:2:0 or 
4:2:2. Then move the diamond on the grid or click the High, Medium, Low, or Draft 
button—the corresponding bit rate and picture structure is shown on the right side of 
the dialog box. 

NOTE: You can edit I-frame clips only. To make an MPEG clip I-frame, drag the 
diamond to the far left side of the grid. 

Figure 33. MPEG Custom Video Quality Settings dialog box  

Table 3. MPEG Video quality (compression) 

Quality Settings Compression in 
Mbps

Chrominance

Draft 4 4:2:0 

Low 8 4:2:0 

Medium (default) 15 4:2:2 

High 24 4:2:2 

Custom 1 or 2 4–44 4:2:2 
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7. In the Preview tab, select a video output for the source clip or master from the Source Video 
Output box. This allows you to watch the source media play out on the monitor during the 
conversion. (See Figure 34.)

Figure 34. Transcode Utility dialog box, Preview tab 

8. From the Target Video Output box, select a video output for the target clip or master. 
This allows you to compare video quality by watching the target media play out on a 
monitor during the conversion, with a few seconds delay from the source media. 

9. If there is media in the list that you have decided not to convert, select it in the media 
pane, then click Remove. 

10. If you want to delete the original clip or master automatically after it is converted, click 
Delete source after conversion. This will save disk space. 

NOTE: A deleted clip or master cannot be restored. 

11. Click Start. The Transcode Description dialog box appears. Enter a descriptive message 
to be stored as part of the transcode history and when done, click OK to continue the 
conversion. 
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Figure 35. The Transcode Description dialog box

The conversion starts with the first clip or master in the list and continues to the last. If 
the media are not deleted (see step 10) the source clips and masters are moved to a 
backup bin. For example, if the source media is in the default bin, the original source is 
moved to a bin called default_bak (bin basename plus _bak). You can stop the 
conversion process at any time by clicking Stop. Start the process again by clicking 
Restart. 

NOTE: An error occurs (listed in the Status column) when a clip is the wrong video 
standard, is already present in the _bak bin, or cannot be opened, among other faults. 

12. Click Close or choose File | Exit. 
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Using a Library System
Media Manager supports both the PLS20 and the PLS200 library systems. The PLS 20 Profile 
Library System is a stand-alone drive for reading and writing to individual magnetic tape 
cartridges. The PLS 200 Profile Library System is a robotic library that stores up to 80 
magnetic tape cartridges. The PLS 200 is a cost-effective mechanism for spot or news storage 
and management, plus a solution and method for the long-term archival of material. Total 
storage capacity is determined by the number of tape cartridges available and the video 
compression method used (MPEG, DVCPRO, or JPEG).

Archiving a Bin or Clip
To archive a clip means to copy it from disk to a cartridge in the library system. Clips are 
always copied into the library when archived: they are never moved. To archive a bin means 
to copy all the clips and masters in the bin to the library system without having to individually 
select each clip or master.

NOTE: The archiving operation copies the data to the tape cartridge, but does not 
update the cartridge directory. Updates can occur when you export the tape, or when 
you specifically perform an update. See “Exporting a Cartridge” on page 73, and 
“Updating and Inventorying Cartridges” on page 74.

To archive a bin or clip using a copy command:

1. Select the bin in the tree pane or the clip in the contents pane that you want to archive. To 
extend the selection, press Shift-Up Arrow or Shift-Down Arrow. Choose Edit | Select All 
or Ctrl-A to select all the media in the contents pane.

2. Choose Copy either from the Edit menu or from the shortcut menu with a right-click. You 
can also click the Copy button on the toolbar.

3. In the tree pane, select the partition icon where you want to archive the bin or clip.

4. Choose Paste or Paste Special either from the Edit menu or from the right-click shortcut 
menu. You can also click the Paste button on the toolbar.

If there is a bin or clip with the same name in the partition where you want to archive it, you 
are prompted to change the name or cancel the operation. Also, a clip can only be added to a 
partition if there is enough space for it.
December 1, 2000 Profile XP  User Manual 69



Chapter 3    Using Media Manager 

70
To archive a clip or bin using drag and drop:

1. In the tree pane, click the cartridge icon where you want to archive a clip. This expands the 
tree pane to reveal the partition icon or icons.

2. Click on the bin that you want to copy or from which you want to copy a clip. The clip icons 
from the bin appear in the contents pane.

3. In the tree pane select the bin icon, or in the contents pane select the clip icon that you want 
to archive. Hold the left mouse button and drag the selected icon to the partition icon in the 
tree pane where you want to archive the bin or clip.

4. If you want to check on the progress of an archive operation, click on the Profile logo or 
choose Tools | Transfer Monitor to view the Transfer Monitor.

Restoring a Bin or Clip
To restore an archived clip means to copy it from a partition in a cartridge in the library system 
to disk. Clips are always copied out of the library when restored: they are never moved.

To restore an archived clip using the copy method:

1. In the tree pane, click the cartridge icon from which you want to restore a clip. This expands 
the tree pane to reveal the partition icon or icons.

2. Click the partition in the tree pane from which you want to restore to reveal the clips in the 
contents pane.

3. In the contents pane, select the archived clip you want to restore. To extend the selection, 
press Shift-Up Arrow or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to select all 
the media in the contents pane.

4. Choose Copy on the Edit menu or from the shortcut menu with the right-click. You can 
also click the Copy button on the toolbar.

5. Select the location where you want to restore the archived clip. This can be a bin or 
anywhere in the contents pane when a bin is selected. The selected location may also be in 
another Media Manager window.

6. Choose Paste on the Edit menu or from the shortcut menu with a right-click. You can also 
click the Paste button on the toolbar.

If there is a clip with the same name in the bin where you want to restore it, you are prompted 
to change the name or cancel the operation.

To restore a clip using the drag and drop method:

1. In the tree pane, click the cartridge icon you want to restore a clip from. This expands the 
tree pane to reveal the partition icon or icons.

2. Click the partition in the tree pane that you want to restore from to reveal the clips in the 
contents pane.

3. In the contents pane, click on the clip icon or icons you want to restore, hold the left mouse 
button, and drag it to the bin icon in the tree pane where you want to restore the clip.

4. If you want to check on the progress of a restore operation, click on the Profile logo or 
choose Tools | Transfer Monitor to view the Transfer Monitor.
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Renaming an Archived Clip
A clip can have a name up to 32 characters long. Spaces are legal characters, but count for two 
characters. Colons (:) and slashes (/) are illegal in clip names. Tildes (~) are only illegal as a 
first character in a clip name. 

To rename an archived clip:

1. In the tree pane, select the library, cartridge, and partition where the archived clip is stored.

2. In the contents pane, select the archived clip you want to rename.

3. Choose Rename from the File menu or from the shortcut menu with a right-click. You can 
also select the clip’s name a second time.

4. Type the new name and press Enter.

NOTE: The renaming operation does not take permanent effect until after an update 
operation (see “Updating and Inventorying Cartridges” on page 74).

Deleting an Archived Clip
To delete an archived clip:

1. In the tree pane, select the library, cartridge, and partition where the archived clip is stored.

2. In the contents pane, select the archived clip or clips you want to delete.

3. Press the Delete or Backspace key, or choose Delete from the File menu or from the 
shortcut menu with a right-click.

When an archived clip is deleted, it is not moved to the Recycle bin. It is removed from the 
library database’s record of archived clips. Also, since tape is not a random access medium, 
the storage space is not reclaimed as it is on the disk drives, and the space cannot be reused 
until all clips in a partition have been deleted.

NOTE: The delete operation does not take effect until after an Update operation (see 
“Updating and Inventorying Cartridges” on page 74).
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Importing a Cartridge
To import a cartridge is to insert or add it into the library system:

1. In the tree pane, select the library icon. If you have a stand-alone drive, you must insert the 
cartridge you are importing into the drive. 

2. Choose Import either from the File menu or from the shortcut menu with a right-click. The 
Import Cartridge dialog box appears (see Figure 36). If you have two or more PLS20 
systems connected simultaneously, you must enter a drive number when prompted. 

Figure 36. Import Cartridge dialog box 

3. Enter a unique label name (number) for the cartridge. This name must match the barcode 
on the cartridge—for example, 00000015. If the label is not unique or matches a label 
already in the library, the cartridge is rejected.

4. Click a button to tell Media Manager how you want to import the cartridge:

- If you want to verify the contents of the cartridge, click Verify the cartridge with its 
library entry. If the label (barcode) matches the one in the library and the directory 
entries match, the cartridge is imported. If the label matches but the directory entries 
do not, the cartridge is rejected. If the library system can find no record of the barcode 
label, the cartridge is stored as an unknown cartridge.

- For a fast import with no verification of the cartridge’s contents, click Do not verify 
the cartridge (fast import). As long as the label matches one in the library, the 
cartridge goes directly into an available slot. If the library system can find no record 
of the barcode label, the cartridge is stored as an unknown cartridge.

- To inventory the cartridge, click Inventory the cartridge and update the library. 
The cartridge is loaded into a transport and its contents are inventoried. The database 
is updated if it did not match what was inventoried.

- To import an unformatted cartridge, click Import unformatted cartridge. The 
cartridge is put into the first available slot and appears in the media tree with an 
unformatted cartridge icon.

- To import a new cleaning cartridge, click Import new cleaning cartridge. The 
library system cannot differentiate between a cleaning cartridge and an ordinary 
cartridge. It must be told when a cleaning cartridge is imported. If you provide a 
unique tape label, the cleaning cartridge is stored in a cleaning cartridge bin.

5. Click Import.
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Exporting a Cartridge
6. A prompt appears requesting that you physically insert the cartridge into the library. Once 
the robot is in position and you insert the cartridge, press any button on the library’s control 
panel.

7. The Importing Cartridge dialog box remains on the screen until the robot puts the cartridge 
in the available slot. Since this is done in the background, click OK at any time.

When the robot retracts with the imported cartridge, it scans the cartridges’s barcode. If the 
barcode does not match the name that was entered for the import, it is rejected.

Exporting a Cartridge
To export a cartridge is to eject or remove it from the library system:

1. In the tree pane, select the icon for the cartridge you want to export.

2. Choose Export Cartridge from the File menu, or from the shortcut menu with a right-click, 
and the Export Cartridge dialog box appears. By default, the cartridge location is Out of 
library.

Figure 37. Export Cartridge dialog box 

3. Select the appropriate box:

- If you select Update the cartridge, the cartridge is loaded into a transport and its 
directory is updated to reflect clip name changes or deletions. Then the cartridge is 
ejected. 

- If you select Permanently remove from the library database, all references to the 
cartridge are deleted from the library database, then the cartridge is ejected. 

- If you select both boxes, the cartridge is loaded into a transport and its directory is 
updated to reflect clip name changes or deletions. This information is saved on the 
cartridge. Then all references to the cartridge are deleted from the library database and 
the cartridge is ejected. 

4. Click Export.

5. A prompt appears requesting that you physically remove the cartridge from the library. 
Once the robot is in position and you remove the cartridge, press any button on the library’s 
control panel.

6. The Exporting Cartridge dialog box remains on the screen until the robot ejects the 
cartridge. Since this is done in the background, click OK at any time. If you are using a 
PLS20, you must manually remove the cartridge from the drive. 
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Updating and Inventorying Cartridges
Using the Media Manager to archive, delete, or rename bins or clips simply updates the library 
database—not the cartridge directory. This is why delete and rename operations are so fast: 
the cartridge is not loaded into a transport. Archive operations do copy data to a cartridge, but 
the cartridge directory is not updated. Once a bin or clip is archived, deleted, or renamed, the 
library database and the cartridge’s physical directory are out of synch.

The update and inventory operations allow you to resynchronize the cartridge directory and 
library database. The update operation rewrites the cartridge directory with the library 
database’s record of what should be on that cartridge. Conversely, the inventory operation 
reads the cartridge directory and rewrites the library database’s entry for that cartridge.

>>> CAUTION: It is very important that you update a cartridge before you inventory the 
cartridge. Updating prior to inventorying ensures that the cartridge directory reflects all 
archivals, renamings and deletions since the last update. If you inventory the tape before 
you update it, any changes to the tape since the last update are effectively lost.

To update one or more cartridges:

1. In the media tree or contents pane, select one or more cartridge icons.

2. On the File menu, or from the shortcut menu with a right-click, click Update. Since the 
update takes several minutes to complete, you are asked to confirm the operation, as shown 
in Figure 38. 

Figure 38. Confirm Update dialog box 

3. Click Yes to update the cartridge or cartridges.
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Updating and Inventorying Cartridges
To inventory one or more cartridges:

1. In the tree or contents pane, select one or more cartridge icons.

2. Choose Inventory either from the File menu or from the shortcut menu with a right-click. 
Since the inventory takes several minutes to complete, you are asked to confirm the 
operation, as shown in Figure 39. 

Figure 39. Confirm Inventory dialog box 

3. Click Yes to inventory the cartridge. 
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Inventorying the Library
There are times when the contents of the library system do not match the record of those 
contents in the library database. This usually occurs when the cartridges have been added or 
removed by hand without appropriate inventories, which is not recommended. The inventory 
operation rescans the barcodes of the cartridges in the library and updates the database to the 
actual library contents.

To inventory the contents of the library:

1. Select a library icon in the tree pane.

2. Choose Inventory from the File menu or from the shortcut menu with a right-click. Since 
this operation may take several minutes, Media Manager asks you to confirm that you want 
to inventory the entire library.

Figure 40. Confirm Inventory dialog box 

3. Click Yes to inventory the entire library.

The inventory operation, like all library operations, is processed in the background. This 
allows you to continue working with the Media Manager while the operation is being 
performed. The Transfer Monitor tool is used to view background transactions. To view the 
Transfer Monitor, click the Profile logo or choose Tools | Transfer Monitor.
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Formatting Cartridges
When you format one or more cartridges, all storage space is reallocated and the cartridge is 
prepared to accept new data.

To format one or more cartridges:

1. Select the cartridge icon or icons in the tree pane

2. Choose Format from the File menu or from the shortcut menu with a right-click. The 
Format dialog box appears (see Figure 41). The Name field shows the name or names of 
the cartridges to be formatted. If more than one cartridge is selected, the number of 
cartridges is shown (see Figure 42).

Figure 41. Format Cartridge dialog box
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Figure 42. Format Cartridge dialog box 

3. Click Single Partition or Multiple Partitions. With a Single Partition, the cartridge or 
cartridges will have one partition when formatted and all clips are archived to the same 
partition. With Multiple Partitions, the cartridge or cartridges will have two or more 
partitions, depending on other settings. You do not actually set the duration of clips, or 
video and audio quality: you simply approximate based on how you anticipate using the 
cartridges. You cannot set the number of partitions directly. If you choose Multiple 
Partitions: 

- To set the anticipated length (time duration) of clips under the partitions, select the 
number of seconds or minutes in the Partition Duration box. Selecting Custom opens 
the Custom Duration box. In the Custom box, enter the duration of seconds in the 
range 1 to 9999.

- To set the anticipated quality of the video that you will use with these cartridges, 
select a video quality from the Anticipated Video Quality box. If you anticipate using 
higher video quality, you will use more tape to store media. This causes the format 
operation to create larger and fewer partitions.

- To set the anticipated audio resolution that you plan to use with these cartridges, select 
either 16 bits or 20 bits from the Anticipated Audio Quality box. Different audio 
qualities affect the amount of tape used and therefore the number of partitions that will 
be created.

- To allow more than one file (clips) under a partition, click Multiple files per partition. 
If unselected, only a single clip may be archived per partition.

4. Click OK.
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Viewing Library, Cartridge and Archived Clip 
Viewing Library, Cartridge and Archived Clip Properties
To view the properties for the library:

1. Select the library icon in the tree pane.

2. Choose Properties either from the File menu or from the shortcut menu with a right-click. 
You can also click the Properties button on the toolbar. The library properties dialog box 
appears.

Figure 43. Properties dialog box for the library 

3. Click OK when you are done viewing the library properties.
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To view the properties for a cartridge:

1. Select a cartridge icon in the tree pane.

2. Choose Properties from the File menu or from the shortcut menu with a right-click. You 
can also click the Properties button on the toolbar. The cartridge properties dialog box 
appears.

Because the size in megabytes is constant, the available time is an approximation based on the 
settings in the Anticipated Video and Audio Quality boxes. The higher the quality, the less 
time is available for storage.

3. Click OK when you are done viewing the cartridge properties.

Figure 44. Properties dialog box for a cartridge
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Viewing Library, Cartridge and Archived Clip 
To view the properties for a archived clip on a cartridge:

1. Select a clip icon in the contents pane.

2. Choose Properties from the File menu or from the shortcut menu with a right-click. You 
can also click the Properties button on the toolbar. The clip properties dialog box appears.

Figure 45. Properties dialog box for an archived clip 

3. Click Read-only if you want to prevent modifying, renaming, or deleting the clip.

4. Click OK when you are done viewing the clip properties.
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Viewing Tape Transport Status
To view the status of the tape transports in the library:

1. Choose Tape Transport Status from the File menu or from the shortcut menu with a 
right-click. The Tape Transport Status dialog box appears.

Figure 46. Tape Transport Status dialog box 

The labels in the dialog box are explained here:

Transport Icon A transport icon is shown for each active transport
in the library. The order of transports in this dialog
does not necessarily reflect the order they appear in
the library system.

Transport Number This is the logical identifier for the transport. It is a
number from 0–255.

Robot Position This is the physical transport identifier. It is a num-
ber from 0–3.

Cartridge Name A cartridge name is shown if one is currently loaded
into the transport.

Disable Removes a transport from service. Click Add to
re-enable the transport.
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Viewing Tape Transport Status
To add a transport to the list of active transports:

1. In the tree pane, select the appropriate library icon.

2. Choose Tape Transport Status from the File menu, or from the shortcut menu with a 
right-click. The Tape Transport Status dialog box appears.

3. Click the Add button. The Add Tape Transport dialog box appears, as shown in Figure 47.

Figure 47. Add Tape Transport dialog box 

4. Enter the logical transport number (0–255).

5. Enter the physical robot position (0–3).

6. Click OK.

7. Click Close when you are done viewing the transport status.

To remove a tape transport from service:

• Click the appropriate Disable button.

To clean a tape transport:

• Click the appropriate Clean button. A tape transport does not need cleaning until the 
“Needs Cleaning” message appears beside the Clean button. The library system will find 
the first available cleaning cartridge in the system and use it to clean the selected 
transport. If the library system is unable to find the cleaning cartridge—that is, there is 
no cleaning cartridge in the library—you will get a message stating that no cleaning 
cartridge was found. 

Clean Loads a cleaning cartridge and cleans the transport

Cleaning Message The message Needs Cleaning appears when the
transport is due for cleaning.

Add Adds a transport to the list of available transports.

Close Close the Tape Transport Status dialog.

Help Opens the help topic on the Tape Transport Status
dialog.
December 1, 2000 Profile XP  User Manual 83



Chapter 3    Using Media Manager 

84
Viewing the Transfer Monitor
When clips are copied to a different machine, the media that is referenced by those clips is also 
copied. This is made possible by using a combination of Ethernet and Fibre Channel networks. 
Ethernet is used for lower-speed database transfers and queries. The high speed Fibre Channel 
network is used for transferring the actual media between machines.

Copying media is done in the background to allow you to continue with your work. Adding to 
and restoring from an archive also is done in the background. Since this may result in more 
than one transfer occurring at the same time, the Transfer Monitor is used to keep track of 
these background tasks. Each time a media transfer is started, a new entry appears in the 
Transfer Monitor.

The Transfer Monitor can be opened at any time. It consists of two tabs: the Network tab 
which shows all copies over Fibre Channel and Duplicates in progress; and the Library tab 
which shows any ongoing library transactions. 

To track background operations with the Transfer Monitor:

• Choose Tools | Transfer Monitor or click the Profile logo on the toolbar. The Transfer 
Monitor dialog box appears. 

Figure 48. Transfer Monitor dialog box 

The Profile logo on the Media Manager toolbar is animated whenever there is an archive item 
in the Transfer Monitor, whether the Transfer Monitor is open or not. If there are only error 
items in the Transfer Monitor the error logo appears, without animation.

The Network tab divides entries into four columns: source, destination, percent complete, and 
average megabytes per second. When copying, source and destination paths are constructed 
using the machine/volume/bin/clip names. A destination clip name may be different from the 
source clip name if the clip was renamed when pasted or moved to the new location (which 
has to be done when a clip with the same name already appears at the new location).
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Viewing the Transfer Monitor
The Library tab divides entries into four columns: operation, source, destination, and percent 
complete. Library operations that occur in the background include archive, restore, inventory, 
update, format, delete, import, clean, and export. The destination column is only filled in for 
the archive and restore operations. The percent complete column will show Pending while a 
cartridge is being loaded into a transport and cued to the correct tape position.

NOTE: Only network, library archive, and library restore transactions can be 
cancelled.

To interrupt a transfer do the following:

1. Click the Network or Library tab depending on the type of transfer you wish to interrupt.

2. Select the transaction you wish to interrupt.

3. Click the Cancel Transaction button. (This button is unavailable unless the transaction is 
highlighted.)

The label for this button is context specific. If an archive transaction was selected, the button 
is labeled Cancel Archive. If a network copy was selected, the button is labeled Cancel 
Transfer.

Occasionally an error will occur while a transfer is in progress. The destination machine may 
have unexpectedly run out of storage, the network connection may have gone down, there may 
have been trouble reading an archive library cartridge. An error is indicated by a change in the 
Profile logo.

In the Transfer Monitor, entries that could not complete due to error are displayed in red and 
their percent complete shows Error. When the entry is selected, a short description of the error 
is shown at the bottom of the window. To remove the entry, select it and then click the 
Remove button.
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Glossary

Access Time
The time it takes to find and retrieve digital information, generally from hard disk 
storage.

AES/EBU
Acronym for Audio Engineering Society/European Broadcasting Union, an industry 
standard for the transmission of serial digital audio information. The standard 
specifies the physical attributes of the link, as well as how the information is 
transmitted along it.

A to D
Analog-to-digital converter. An electronic component that converts incoming analog 
signals into its digital representation.

Analog video
Video represented as a continuously variable electrical signal. Consumer TV and 
domestic VCRs are analog video devices. Analog video can be converted to digital 
format to be stored and manipulated by computer or other digital devices.

Archive library
The archive library is an automated tape storage device used to supplement a 
machine’s disk storage. The library consists of digital tape cartridges and, in some 
cases, robot that moves cartridges to and from tape transports.

Audio board
The audio board on the Profile XP that provides 16 channels of analog, embedded 
digital, and AES/EBU digital audio. You can install up to two audio boards in a 
Profile XP for 32 channels of audio. 

Assemble record mode
Video and all audio tracks assigned to a machine are recorded simultaneously, along 
with timecode, and any previous contents are overwritten. Traditionally this mode is 
used when appending to a master tape that has not had black, timecode, and control 
track previously recorded before editing.

Audio I/O
The audio path through the Profile XP Media Platform video disk recorder, especially 
the crosspoint circuitry that routes the audio within the Profile system.

Auto Start
A feature that lets you enter a timecode and have the record buffer start recording at 
that timecode.
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Bit rate 
The rate at which video streams in megabits per second (Mb/sec). The bit rate is a 
reflection of quality—the higher the bit rate, the higher the quality of video. However, 
video data stored at a high bit rate consumes more disk storage space than data stored 
at a lower rate. Bit rates can be as low as 6 Mb/sec and as high as 54 Mb/sec. The 
default video quality bit rate is 24 Mb/sec, which is broadcast quality. 

BNC
Connector used in professional A/V components. The BNC connection provides 
optimum shielding between the video input signal lines to provide the best possible 
performance. BNC was recently adopted as an alternate AES signal connector.

B Picture
A B picture is a bidirectionally-predictive picture used in MPEG video compression. 
MPEG uses motion prediction to increase efficiency, that is, it reduces data by not 
duplicating pixels that do not change from frame to frame. A B picture relies on data 
from both forward and backward motion vectors to determine how a future frame will 
be composed. See GOP, I-frame, P Picture. 

Button (on the display)
A small display box that has a raised appearance and contains text. Generally, clicking 
on a button activates a function or performs some action. See Clicking.

Button (on the mouse)
The two or three buttons on the top of the mouse.

Capture
Generally, the act of storing digital audio and video in memory or on a disk. The 
process may involve converting an analog signal to a digital one. Some compression 
of the digital data may be involved.

Cartridge tape
A tape used in the library that stores video and audio in digital form.

CD-ROM
Compact Disc-Read-Only Memory, the preferred medium for multimedia storage 
because of its large capacity, high quality, ease of use, and low cost.

Channel
A collection of video, audio, and timecode resources used for either playing or 
recording.

Chroma
A term that describes the saturation or vividness of a color. A chroma of 0 describes 
a neutral, gray color. Chroma ranges to the most vivid color a screen or printer 
generates for a specific hue and value. See Hue.

Cleaning cartridge
A special tape cartridge that cleans tape transports on demand.
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Clicking
Quickly pressing and releasing the left mouse button (usually) without moving the 
pointer.

Clip
A clip is a reference to recorded video or audio tracks from a single source, and may 
include timecode. If a clip includes both video and audio, they must be synchronous. 
A reference to several clips edited together is called a master. Deleting a clip will 
delete its associated material only if that material is not used by another clip or master. 

Clip position 
Clip position refers to the current location in a clip, denoted by timecode. 

CODEC
CODEC is an acronym for Coder/Decoder, a device which encodes and decodes a 
specific data type. For example, a JPEG codec compresses CCIR 601 digital 
component video for storage on disk, but can also decompress the stored data and 
return it to its original CCIR 601 digital componnet format.

Command line
The line that you type to invoke a program or initiate an action. A command line 
usually contains the application program name, along with optional arguments known 
as command-line options.

Composite video
A single video signal composed of combined luminance and chrominance 
information.

Component video
Typically the transmission or storage of video as a separate luminance and 
chrominance information, such as Y, B–Y, R–Y, or Y, Cr, Cb.

Compression, video
A technique for reducing the amount of space needed to store images or sequences of 
images. DVCPRO 25, JPEG, Motion-JPEG (M-JPEG) and MPEG are examples of 
video compression techniques.

Data cartridge
A digital tape cartridge that is capable of storing media in large quantities.

dB
Decibel. In theory, the minimum change in sound intensity that the human ear can 
distinguish; also, a relative unit used to compare the strength of acoustic signals.

Default
A value that is automatically assigned or used in the absence of any other input. For 
example, a new Profile system shipped from the factory is zero-timed by default while 
E to E mode is the nondefault setting.
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Dialog box
A box displayed in a computer application’s graphical user interface where you 
choose options and enter information. Use the mouse or keyboard to move from field 
to field, click on buttons and position the text insertion point. Enter information with 
the keyboard.

Digital
In digital audio/video systems, sounds and images are converted into a series of binary 
values (ones and zeros).

D to A
Digital-to-analog converter. A device used to convert digital signals into an analog 
form. For example, compact disc players use D to A convertors to convert the digital 
information on the CD into analog audio suitable for amplification.

Disk expansion unit
A product (PDX208 and PDX218) that adds disk storage to a Profile video disk 
recorder (PDR).

Disk Utility
The Profile Disk Utility tool is used to maintain Profile hard drives. This includes 
formatting and labeling disk volumes, eliminating bad blocks, and updating hard 
drives with new microcode.

Display
A device that receives video output from a display adapter such as VGA card and 
displays the video output on a screen.

Dragging
Pressing and holding down the left mouse button while moving the pointer. The 
mouse pointer must be over an object such as a file.

Drop-frame
In NTSC, you don't actually get 30 frames per second; the real number is about 29.97 
fps. Timecode usually assumes 30 fps. To account for the discrepancy, drop-frame 
timecode skips or drops two timecode values at the beginning of every minute except 
every tenth minute. This allows timecode to exactly match a real-time clock on 525/
60 systems. This correction is not needed on 625/50 systems because the frame rate 
is exactly 50 fps.

E to E (EE)
Electronics to Electronics mode routes audio and video input directly to output.

Edit
The process of creating or refining a sequence of media (clips) in a specific order.
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EDL
An Edit Decision List is a list of events that include the source to be recorded, and 
where to record it. In addition, an EDL can include information about transitions 
(cuts, dissolves, wipes), transition durations, effects, etc.

Factory default
The value assigned to a parameter as delivered from the factory. See Default.

Field
A part of the total number of lines that represent a video image, scanned in two passes. 
For example, an NTSC 525-line frame is divided into 262.5-line fields. See Frame.

Firmware
Software instructions that are permanently stored in the memory of a computer and 
are not lost when you turn the power off.

fps
The abbreviation for frames per second, the standard way of measuring the speed of 
video playback. Thirty fps is considered real-time playback in NTSC, 25 fps in PAL. 
24 fps is standard for film and is considered animation speed playback. In the range 
of 12 to 15 fps, the human eye can detect the difference between one frame and the 
next; visually this appears as a jerky motion, or flicker.

Frame
The standard unit of measure for film and video. One frame represents one complete 
still image, divided into two fields.

Frequency response
The frequency range which an electronic component can accurately reproduce. 
Humans (some) can hear from 20 Hz to 20,000 Hz (20 KHz). An ideal audio 
component would have a frequency response, totally flat and without any deviation, 
from 20 Hz to 20 KHz. Frequency response specifications are measured in decibels 
(dB), based on how closely an output’s response resembles that of the input.

Genlock
This term defines the relationship between video paths. Two video signals that are 
exactly synchronized are said to be genlocked.

GUI
A Graphical User Interface (GUI) provides a visual way to interact with computer 
software. GUIs allow people to control an application by using a pointing device such 
as a mouse to perform operations. The usual alternative to a GUI is a command-line 
interface, which requires people to type in application-specific commands following 
precise rules of syntax. GUIs are considered easier to use than command-line 
interfaces.

Group
In audio terms, this provides the ability to group tracks to perform functions across 
several tracks at the same time, such as gain, mute, etc. 
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GOP
A Group of Pictures (GOP) is part of the video compression scheme used by MPEG. 
MPEG uses motion prediction to increase efficiency, that is, it reduces data by not 
duplicating pixels that do not change from frame to frame. It does so by relying on a 
GOP. A GOP is composed of I-frames, B pictures, and P pictures. See B Picture, 
I-frame, P Picture. 

Hard disk
Computer systems use hard disks as permanent storage devices. Information is 
magnetically recorded on spinning platters for quick access.

Hardware
The physical parts of a system, such as a computer, display monitor, or keyboard.

Help
Profile software applications come with on-line help manuals that include examples, 
demonstrations, and reference information about using the application. The manual, 
and the Help window it is displayed in, follow the Microsoft standard.

Hertz (Hz)
Hertz is the unit of frequency named after the physicist Heinrich Hertz (1857–1894). 
One hertz (Hz) is equal to 1 cycle/second.

Hue
A term that describes a color family (for example, red or yellow). Hue is a polar 
coordinate—that is, it moves in a circular motion around the color spectrum—and 
ranges from 0 to 360, with 0 being red. Hue is measured in degrees. See Chroma.

I-frame
MPEG uses motion prediction to increase efficiency, that is, it reduces data by not 
duplicating pixels that do not change from frame to frame. It does so by relying on a 
GOP. A GOP is composed of I-frames, B pictures, and P pictures. An I-frame (or 
Intra-coded picture) is analogous to a JPEG frame in that it is a self-contained picture. 
It does not use motion vectors as do the B picture and P picture. See B Picture, P 
Picture. 

Input device
A device that allows you to send information to a software application. Typical input 
devices include keyboards, mice, tablets, and trackballs. See Pointer and Pointing 
Device.

Insert record mode
In insert record mode, audio and video material can be recorded independently. New 
material can replace existing material anywhere in the program. Insert record mode 
requires timecode on the destination.

Interface
A common connection that is used for sending or accepting information and control 
between programs and machines.
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Keyboard
An alphanumeric input device that allows communication with software applications.

Library system
The Profile Library System (PLS200) is a robotic tape library that provides affordable 
mass storage for the Profile video disk recorder. Profile Library Systems attach 
directly to the external SCSI-2 bus on Profile video disk recorders (PDRs). Profile 
Library Systems may not be connected to Profile XP Media Platforms.

LTC
Longitudinal Time Code is typically an analog audio track or a dedicated address 
channel on a tape. LTC can’t be read in still mode, and may not be reliable during 
low-speed shuttle operations.

Media files
Audio, video, and timecode sources that have been captured by the Profile disk 
recorder are considered media. Media is stored on disk as media files. Audio and 
video clips do not contain media, but instead reference positions in a media file.

Memory
A component of a computer system used for virtually instantaneous temporary 
storage and retrieval of information (data) or instructions (programs). Information in 
memory is volatile, and is lost when the computer is shut down. Storing information 
on a permanent storage device such as a hard disk or a tape allows for retrieval during 
another work session.

Menu
A list of commands or functions that you select with a pointer. A menu is normally 
displayed in a small window.

Monitor
Two-channel audio output of selected machine tracks. Generally, audio systems or 
video displays used in a studio environment to control quality. Also, a video display 
device, without audio capabilities.

Mouse
An input device that, when moved across a flat surface, causes the pointer to move 
across a screen. The mouse usually has buttons that you press to send signals. These 
signals, in turn, accomplish certain functions. The representation of the mouse on the 
screen is called the pointer. See Pointer.

MPEG
MPEG (Moving Picture Experts Group) is a set of standards used for compressing 
digital video and audio. MPEG uses compression methods that maintain high quality 
while requiring smaller bandwidths to transport video and audio streams. 

NTSC
The standard composite color format used in North America and Japan that was 
developed by the National Television Standards Committee.
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Off-line cartridge
The archive library has immediate access of up to a limited number of cartridges. 
However the library database can contain information about any number of cartridges. 
A cartridge is considered off-line when it has been ejected from the library storage 
device, but remains in the library database.

PAL
The Phase Alternate Line standard is used to encode color information in Western 
European composite video.

Panel
The graphical representation of a channel. in Profile applications such as VdrPanel 
and TimeDelay. A record panel shows controls for the record channel. A player panel 
shows controls for a play channel.

Partitions
To give the archive tape transports some degree of random access, a data cartridge is 
divided into an number of partitions. Media may be added to a partition until that 
partition is full. Deleting media from one partition does not affect any other partition.

Parameter
A variable that is given a specific value. This value is passed to a program before 
execution.

Pixel
The smallest part of a display memory that can be addressed.

Playback
Playback is the act of playing a clip, track or master loaded on a machine at any rate.

Playback delay
The amount of time that the playback channel is behind the record channel.

Pointer
The pointer allows you to make selections in menus, to size and position windows and 
icons, and to select the window where you want to send the input. The window 
manager, such as Windows NT, determines the shape of the pointer. See Pointing 
Device.

Pointing device
Typically a mouse, tablet, or some other device with effective dimensional motion. 
See Pointer.

Port
A physical connection (such as a multi-pin connector or coaxial connector) and its 
associated firmware, that permits one computing device to communicate data and 
control information with another computing or peripheral device.
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P Picture
A P picture is a predictive-coded picture used in MPEG video compression. MPEG 
uses motion prediction to increase efficiency, that is, it reduces data by not duplicating 
pixels that do not change from frame to frame. A P picture relies on data from 
forward-moving motion vectors to determine how a future frame will be composed. 
See B Picture, GOP, I-frame. 

Protocol
A set of rules that allows computers to transfer information across a network to other 
computers.

Read-only memory (ROM)
Memory that is not erased when power is turned off. It is also called firmware. The 
firmware in a computing device allows it to boot without being connected to a host 
computer.

Real-time
Generally considered to be 30 fps in NTSC, 25 fps in PAL, 24 fps for film. In 
computer terms, processing information as it becomes available, rather than storing 
for processing at a later time.

Record Buffer
Determines the length of the Time Delay clip that the record buffer loop records on.

Resource
A resource is a Profile input, MPEG encoder, or output. You allocate resources for 
exclusive use by any application, such as Tool Box Editor, List Manager, and 
VDRPanel. You should free up (deallocate) unneeded Profile resources whenever 
possible to that they can be used by other applications.

RGB
An additive method of combining percentages of red, green, and blue primary colors 
to form other colors.

ROM
See Read-Only Memory.

RS-232-C
A standard serial communications interface for data communications, commonly 
used for communications between a computer and modem, or to control automated 
devices which don’t have a conventional computer operating system.

RS-422
A standard serial communications interface for data communications, similar to 
RS-232-C, but good for longer distance cabling. It is typically used for 
communications in a broadcast or post-production environment between devices such 
as VTRs, mixers, and controllers.
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SCSI Channel (Small Computer System Interface)
The interface between the Profile processor and the disk array or library system. It is 
fast and wide and provides for speeds up to 20 Mbytes/second on a 16-bit bus.

SDI
An acronym for Serial Digital Interface, a standard for transmitting CCIR 601 digital 
video over a pair of conductors (coaxial cable).

SECAM
France and Russia use the Séquence Couleur À Mémoire standard color format.

Serial port
Usually, the standard RS-232-C of a personal computer. Attach a serial cable to 
communicate with a peripheral device such as a modem or printer.

S/N Ratio
The Signal-to-Noise Ratio, measured in decibels, is the ratio between the maximum 
signal level and the noise level with no signal present. The higher the value, the better 
the sound reproduction.

Source
In Profile operations, a source is any signal (video, audio, or timecode) presented to 
the machine inputs. A VTR output, a satellite downlink, a camera output, and a 
facility router output are all examples of sources.

Status bar
The status bar at the bottom of most windows provides status information, short 
explanations of commands and errors.

Tape
See Cartridge Tape.

Text insertion point
The I-shaped pointer which appears in a text input area. Clicking the mouse in a text 
input area causes the text cursor to appear in that area. Whatever information you type 
on the keyboard appears in the text input area displaying the text cursor.

Timecode Source
LTC, VITC, Timecode generator

TimeDelay
The name of the application and the amount of time that elapses between the start of 
the record channel and the start of the playback channel.
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Tool Tips
A tool tip is a small pop-up window that displays a single line of text describing the 
purpose of a control in a window. A tool tip is hidden most of the time, appearing only 
when the user puts the cursor on a tool and leaves it there for approximately one-half 
second. The tool tip appears near the cursor and disappears when the user clicks a 
mouse button or moves the pointer off of the tool.

Tracks
Clips and masters are made up of individual tracks. A clip may consist of any 
combination of a video track, timecode track, and up to 16 audio tracks. A master may 
consist of any combination of a timecode track, 0-4 video tracks, and 0-16 audio 
tracks.

Trimming
Shortening an originally recorded media file to a desired duration using the In and Out 
marks. Material beyond the In and Out points is removed from the volume unless it is 
used in another clip or master.

Video interface
The link to or from the internal video router and the external video signal. An example 
is a composite analog input channel. This path takes a composite analog video signal 
and converts it to 8-bit component parallel digital and places it on the video router. 
Another example is the component serial digital output. This path takes component 
parallel digital video from the video router and converts to serial digital component 
format.

Video disk recorder/ server
A device such as the PVS1000 Media Platform that stores audio and video as digital 
information on disks.

VITC
Vertical Interval Time Code is encoded into the video lines at the start of field. VITC 
can be read during still frames, but becomes unreliable at frame rates faster than 
normal play speed, such as fast shuttle operations.

Video router
The video path through a system. The crosspoint circuitry that routes the video within 
the Profile video disk recorder is a router.

Volume
A volume is a logical set of disks, such as the RAID disks connected to a PVS1000, 
which are used as a grouping of disks for the storage of audio and video information. 
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A
A to D 87
Access Time 87
Adding a Profile machine 48
AES/EBU 87
Analog video 87
API 12
Application programming interface 12
Archive library 87
Archived clip properties 79
Archiving a bin or clip 69
ASPB 87
Assemble record mode 87
Audio

I/O 87
monitor in VdrPanel 32

Auto Start 87

B
B picture 88
Back One Field 28
Bin 45

archiving 69
creating a new 56
deleting 56
renaming 56
restoring from archive 70

Bit rate 88
BNC connections 88
BVW clip length 22

C
Capture 88
Cartridge properties 79
Cartridge Tape 88
CD-ROM 88
Channel 88
Chroma 88
Cleaning Cartridge 88
Clip 89

archiving 69
clip list 40

define 33
delete 38, 57
edit a list 42
eject 34, 38
group 40
load 35
lock 37
long names 38
new 33
play 35
protect 37
renaming 36, 57
restoring from archive 70
short names 38
striping 38
unlock 37

Clip length (BVW) 22
Clip list 40
Clip marks 22
Clip Name Box 29
Clip position 89
Clip Position Bar 27
Closing an application 15
CODEC 89
Collapsing the media tree 50
Command Line 89
Component video 89
Composite video 89
Compression 89
ContentShare Explorer 16
Controller 22
Copying media in Media Manager 53
Ctrl key 10

D
D to A 90
Data cartridge 89
dB 89
Default 89
Defining clips 33
Deleting an archived clip 71
Deleting clips 38
Deleting media in Media Manager 57
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Desktop, Windows NT 14
Dialog box 90
Disk Expansion Unit 90
Disk Utility 90
Display 90
Double-clicking 10
Drop-frame 90
Drop-frame timecode 25
Duplicating media in Media Manager 55

E
E to E 27, 90
Editing a clip list 42
Editor, Tool Box 19
EDL 91
Ejecting clips 34, 38
Emptying the Recycle Bin in Media Manager 

58
Expanding the media tree 50
Explore in Media Manager 50
Exporting a cartridge 73

F
Factory default 91
Fast Forward 27
Fibre Channel 18, 45
Field 91
Finding Clips and Masters 62
Finding media in Media Manager 62
Firmware 91
Formatting cartridges 77
Forward One Field 28
fps 91
Frame 91
Free Run timecode 24
Freeze timecode 24
Frequency response 91

G
Generator, timecode 24
Genlock 91
Go to Clip Beginning 28
Go to Clip End 28
GOP 92

Graphical user interface 91
Group 91
Group Name Box 28
GUI 91

H
Hard disk 92
Hardware Communication Monitor 46
Help 92
Help files 15
Hertz (Hz) 92
Hue 92

I
Icon definitions 50
I-frame 92
Importing a cartridge 72
In marks 28, 43
Input device 92
Insert record mode 92
Inventorying a cartridge 74
Inventorying the library 76

K
Keyboard 93
Keys, shortcut 29

L
Library properties 79
Library system 93
List Manager 18, 19
Loading clips 35
Lock to Field Number 24
Locking clips 37
Logging in 13
Long clip names 38
Loop 26
Louth 12
LTC 24, 93

M
Manual conventions 10
Manually logging in 13
Marks 22, 28, 43
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delete 57
renaming 57

Media files 93
Media Manager 16, 45-85

archiving a bin or clip 69
copying and pasting media 53
creating, renaming, deleting bins 56
deleting an archived clip 71
deleting clips and masters 57
duplicating media 55
emptying recycle bin 58
exporting a cartridge 73
formatting cartridges 77
icons 50
importing a cartridge 72
inventorying the Library 76
library, cartridge, and clip properties 79
moving media 53
renaming an archived clip 71
renaming clips and masters 57
restoring a bin or clip from archive 70
starting and exiting 46
tape transport status 82
toolbar 52
Tools menu 47
Transfer Monitor 84
updating and inventorying cartridges 74
using a Library System 69-83
viewing properties 59, ??-61
viewing the hierarchy 50

Media properties 59
Memory 93
Menu 10, 93
Monitor 93
Mouse 93
Moving media in Media Manager 53
MPEG 63, 93

N
Network host list

add or remove machine 49
New clips 33
Normal 26
NTSC 93

O
Odetics 12
Off-line cartridge 94
Out marks 28, 43

P
P picture 95
PAL 60, 94
Panel

Back One Field 28
basics 26
Clip Name Box 29
Clip Position Bar 27
Fast Forward 27
Forward One Field 28
Go to Clip Beginning 28
Go to Clip End 28
Group Name Box 28
Loop 26
making active 30
Normal 26
PB/EE 27
Play 27
Playback 27
Record 27
Remove In Mark 28
Remove Out Mark 28
Rewind 27
Set In Mark 28
Set Out Mark 28
Shuttle Bar 28
Shuttle Rate 28
Stop 27
tiling 30
Timecode 27
Trim from Out Mark 28
Trim to In Mark 28

Parameter 94
Partitions 94
Paste Special 54
PB/EE 27
Peak hold 32
Pixel 94
Play 27
Playback 27, 94
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Playback delay 94
Playing clips 35
PLS20 and PLS200 Profile Library Systems 

45
PLS20 Profile Library System 69
PLS200 Profile Library System 69
Pointer 94
Pointing device 94
Port 94
Powering on 13
Profile Protocol 12
Properties 79
properties, media 59
Protecting clips 37
Protocol 95

R
Read-only memory 95
Real-time 95
Record 27, 34
Record Buffer 95
Record Capacity 31
Regenerate timecode 25
Remote Profile machine 48
Remove In Mark 28
Remove Out Mark 28
Removing a Profile machine 48
Renaming an archived clip 71
Renaming clips 36
Renaming media in Media Manager 57
Resources 95
Restoring an archived bin or clip 70
Rewind 27
RGB 95
Right-click 10
ROM 95
Router, video 97
RS-232-C 95
RS-422 95

S
S/N Ratio 96
Save Group of Clips 40
SCSI 96
SDI 96

SECAM 96
Select timecode 24
Serial port 96
Set In Mark 28
Set Out Mark 28
Short clip names 38
Shortcut keys, VdrPanel 29
Shuttle Bar 28
Shuttle Rate 28
Size box 26
Software Development Kit 12
Source 96
Starting an application 15
Status bar 96
Status Bar, Media Manager 47
Stop 27
Striping a clip 38

T
TC Recorder 24
TekCfg 12
TekPdr 12
TekRem 12
TekVdr 12
TekVfs 12
TekVme 12
TekXfr 12
Text insertion point 96
Timecode 24, 27

display 27
drop-frame 25
free run 24
freeze 24
lock to field number 24

Timecode Source 96
TimeDelay 18
Tool Box Editor 18, 19
Tool Tips 97
Toolbar

Media Manager 47
Toolbar buttons 52
Tracks 97
Transcode Utility 63
Transfer Monitor 84
Transport status 82
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Tree hierarchy 50
Trim from Out Mark 28
Trim to In Mark 28
Trimming 97
Type box 26

U
Unlocking clips 37
Updating a cartridge 74

V
VdrPanel 16, 19

shortcut keys 29
Video disk recorder/server 97
Video interface 97
Video router 97
VITC 24, 97
Volume 45, 51, 97
VTR 11

W
Windows NT 4.0 15
Windows NT desktop 14
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